
Instruction Manual

AutoPatch Matrix Switchers

Epica DGX 144
Distribution Matrix

REV C: 1/25/2011



AMX Limited Warranty and Disclaimer
This Limited Warranty and Disclaimer extends only to products purchased directly from AMX or an AMX Authorized 
Partner which include AMX Dealers, Distributors, VIP’s or other AMX authorized entity. 

AMX warrants its products to be free of defects in material and workmanship under normal use for three (3) years from 
the date of purchase, with the following exceptions:

• LCD Panels are warranted for three (3) years, except for the display and touch overlay components are 
warranted for a period of one (1) year.

• Disk drive mechanisms, pan/tilt heads, power supplies are warranted for a period of one (1) year.

• AMX lighting products are guaranteed to switch on and off any load that is properly connected to our lighting 
products, as long as the AMX lighting products are under warranty. AMX also guarantees the control of 
dimmable loads that are properly connected to our lighting products. The dimming performance or quality 
there of is not guaranteed, due to the random combinations of dimmers, lamps and ballasts or transformers.

• AMX software is warranted for a period of ninety (90) days.

• Batteries and incandescent lamps are not covered under the warranty.

• AMX AutoPatch Epica, Modula, Modula Series 4, Modula Cat Pro Series and 8Y-3000 product models will be 
free of defects in materials and manufacture at the time of sale and will remain in good working order for a 
period of three (3) years following the date of the original sales invoice from AMX. The three-year warranty 
period will automatically be extended to the life of the product (Limited Lifetime Warranty). The life of the 
product extends until five (5) years after AMX ceases manufacturing the product model. The Limited Lifetime 
Warranty applies to products in their original installation only. If a product is moved to a different installation, 
the Limited Lifetime Warranty will no longer apply, and the product warranty will instead be the three (3) year 
Limited Warranty.
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Note: The complete Warranty is at www.amx.com.



Contents
Contents

ESD Warning .......................................................................................................1
Important Safety Information and Instructions....................................................2
Information et directives de sécurité importantes...............................................3
Notices ................................................................................................................4
Overview and General Specifications ..................................................................7

Applicability Notice ................................................................................................................. 7

Product Notes ......................................................................................................................... 8

Front View............................................................................................................................... 9

Rear View .............................................................................................................................. 10

General Specifications ........................................................................................................... 13

Configuration Information and Control Options.................................................................... 13

System Diagnostic Options ................................................................................................... 15

Installation and Setup........................................................................................17
UL Site Requirements ............................................................................................................ 17

UL Safety Certifications, Notices, and Recommendations for Laser Products ....................... 17

Site Recommendations .......................................................................................................... 18

General Hazard Precautions .................................................................................................. 18

Unpacking.............................................................................................................................. 19

System Setup Options ........................................................................................................... 20

Rack Installation and System Setup ....................................................................................... 20

Linking Enclosures ................................................................................................................. 23

Attaching External Controllers .............................................................................................. 30

Attaching Inputs and Outputs ............................................................................................... 36

Applying Power and Startup ................................................................................................. 38

Redundant Power Supply (RPS) ............................................................................................. 40

Executing a Test Switch......................................................................................................... 41

Technical Support.................................................................................................................. 43

Epica DGX 144 SC Fiber Boards........................................................................45
Specifications Epica DGX 144 SC Fiber ................................................................................. 46

System Setup with DGX Modules.......................................................................................... 47

Safety Recommendations for Laser Products ........................................................................ 48

Attaching Cables ................................................................................................................... 48

Epica DGX 144 HD-15 RGBHV Input Board.......................................................51
Specifications Epica DGX 144 HD-15 RGBHV........................................................................ 52

Attaching Cables ................................................................................................................... 53

Board Configuration .............................................................................................................. 54
iEpica DGX 144 Instruction Manual



Contents
Epica DGX 144 DVI Boards............................................................................... 59
Specifications Epica DGX 144 DVI .........................................................................................60

Attaching Cables ...................................................................................................................61

Appendix A – EDID Programmer...................................................................... 63
EDID Overview ......................................................................................................................63

Determining the Need for EDID Programming......................................................................64

Installing the EDID Programmer ............................................................................................65

Reading and Saving EDID Data from a Destination Device ...................................................65

Writing EDID Data to a DVI or HD-15 RGBHV Input Connector ............................................66

Appendix B – Managing Configuration Files .................................................... 69
Installing XNConnect .............................................................................................................70

Opening a Configuration File ................................................................................................71

Discovering a System.............................................................................................................72

Navigating the Interface........................................................................................................73

Modifying a Configuration File ..............................................................................................74

Loading a Configuration File .................................................................................................77

Device Discovery Support .....................................................................................................77

Appendix C – APDiagnostics ............................................................................ 79
Overview ...............................................................................................................................79

System Requirements ............................................................................................................79

Installing APDiagnostics ........................................................................................................79

Modes....................................................................................................................................81

Main Screen and Menus.........................................................................................................82

Communications ....................................................................................................................92

Appendix D – Programmer’s Interface for System Diagnostics ........................ 93
System Component Information ............................................................................................93

Using BCS to Access System Diagnostic Information.............................................................94

Appendix E – Board Replacement .................................................................... 97
Procedure Overview ..............................................................................................................97

Safety Recommendations for Laser Products ........................................................................98

Replacing or Adding a Board.................................................................................................98

Updating the System Configuration ....................................................................................101
ii Epica DGX 144 Instruction Manual



ESD Warning
ESD Warning

To avoid ESD (Electrostatic Discharge) damage to sensitive components, make sure you are properly 
grounded before touching any internal materials.

When working with any equipment manufactured with electronic devices, proper ESD grounding 
procedures must be followed to make sure people, products, and tools are as free of static charges as 
possible. Grounding straps, conductive smocks, and conductive work mats are specifically designed for 
this purpose. 

Anyone performing field maintenance on AMX AutoPatch equipment should use an appropriate ESD 
field service kit complete with at least a dissipative work mat with a ground cord and a UL listed 
adjustable wrist strap with another ground cord. These items should not be manufactured locally, since 
they are generally composed of highly resistive conductive materials to safely drain static charges, 
without increasing an electrocution risk in the event of an accident. ESD protective equipment can be 
obtained from 3M™, Desco®, Richmond Technology®, Plastic Systems®, and other such vendors.
1Epica DGX 144 Instruction Manual



Important Safety Information and Instructions
Important Safety Information and Instructions

When using and installing your AMX AutoPatch product, adhere to the following basic safety 
precautions. For more information about operating, installing, or servicing your AMX AutoPatch 
product, see your product documentation.

z Read and understand all instructions before using and installing AMX AutoPatch products.

z Use the correct voltage range for your AMX AutoPatch product.

z There are no user serviceable parts inside an AMX AutoPatch product; service should only be 
done by qualified personnel.

z If you see smoke or smell a strange odor coming from your AMX AutoPatch product, turn it 
off immediately and call technical support.

z For products with multiple power supplies in each unit, make sure all power supplies are 
turned on simultaneously.

z Use surge protectors and/or AC line conditioners when powering AMX AutoPatch products.

z Only use a fuse(s) with the correct fuse rating in your enclosure.

z Make sure the power outlet is close to the product and easily accessible.

z Make sure the product is on or attached to a stable surface.

z Turn off equipment before linking pieces together, unless otherwise specified in that product’s 
documentation.

z For safety and signal integrity, use a grounded external power source and a grounded power 
connector.

z Turn off and unplug an enclosure before adding or removing boards, unless otherwise 
specified in that product’s documentation.

z To avoid shock or potential ESD (Electrostatic Discharge) damage to equipment, make sure 
you are properly grounded before touching components inside an AMX AutoPatch product.
2 Epica DGX 144 Instruction Manual



Information et directives de sécurité importantes
Information et directives de sécurité 
importantes

Veuillez vous conformer aux directives de sécurité ci-dessous lorsque vous installez et utilisez votre 
appareil AMX AutoPatch. Pour de plus amples renseignements au sujet de l’installation, du 
fonctionnement ou de la réparation de votre appareil AMX AutoPatch, veuillez consulter la 
documentation accompagnant l’appareil.

z Lisez attentivement toutes les directives avant d’installer et d’utiliser les appareils AMX 
AutoPatch.

z Le voltage doit être approprié à l’appareil AMX AutoPatch.

z Les appareils AMX AutoPatch ne contiennent aucune pièce réparable par l’usager; la 
réparation ne doit être effectuée que par du personnel qualifié.

z Si de la fumée ou une odeur étrange se dégagent d’un appareil AMX AutoPatch, fermez-le 
immédiatement et appelez le Service de soutien technique.

z Veillez à ce que tous les blocs d’alimentation des appareils dotés de blocs d’alimentation 
multiples dans chaque unité soient allumés simultanément.

z Servez-vous de protecteurs de surtension ou de conditionneurs de lignes à courant alternatif 
lorsque vous mettez les appareils AMX AutoPatch sous tension.

z Placez uniquement des fusibles de calibre exact dans les boîtiers.

z Veillez à ce que la prise de courant soit proche de l’appareil et facile d’accès.

z Veillez à ce que votre appareil AMX AutoPatch soit installé sur une surface stable ou qu’il 
y soit fermement maintenu.

z Fermez toutes les composantes de l’équipement avant de relier des pièces, à moins 
d’indication contraire fournie dans la documentation de l’appareil.

z Par mesure de sécurité et pour la qualité des signaux, servez-vous d’une source d’alimentation 
externe mise à la terre et d’un connect d’alimentation mis à la terre.

z Fermez et débranchez le boîtier avant d’ajouter ou d’enlever des plaquettes, à moins 
d’indication contraire fournie dans la documentation du appareil.

z Pour éviter les chocs ou les dommages éventuels causés à l’équipement par une décharge 
électrostatique, veillez à ce le dispositif oit bien relié à la terre avant de toucher les 
composantes se trouvant à l’intérieur d’un appareil AMX AutoPatch.
3Epica DGX 144 Instruction Manual



Notices
Notices

Copyright Notice

AMX© 2011 (Rev C), all rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of AMX. Copyright protection claimed 
extends to AMX hardware and software and includes all forms and matters copyrightable material and 
information now allowed by statutory or judicial law or herein after granted, including without 
limitation, material generated from the software programs which are displayed on the screen such as 
icons, screen display looks, etc. Reproduction or disassembly of embodied computer programs or 
algorithms is expressly prohibited. 

Liability Notice

No patent liability is assumed with respect to the use of information contained herein. 

While every precaution has been taken in the preparation of this publication, AMX assumes no 
responsibility for error or omissions. No liability is assumed for damages resulting from the use of the 
information contained herein. 

Further, this publication and features described herein are subject to change without notice.

US FCC Notice

The United States Federal Communications Commission (in 47CFR 15.838) has specified that the 
following notice be brought to the attention of the users of this product.

Federal Communication Commission Radio Frequency Interference Statement: 

“This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

If necessary, the user should consult the dealer or an experienced radio/television technician for 
additional suggestions. The user may find the booklet, How to Identify and Resolve Radio-TV 
Interference Problems, prepared by the Federal Communications Commission to be helpful.”

This booklet is available from the U.S. Government Printing Office, Washington, D.C. 20402, Stock N. 
004-000-00345-4.

Use shielded cables. To comply with FCC Class A requirement, all external data interface cables and 
adapters must be shielded.
4 Epica DGX 144 Instruction Manual



Notices
Trademark Notices 

AMX®, AutoPatch®, NetLinx®, and SmartScale™ are trademarks of AMX.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

HyperTerminal® is a copyright product of Hilgraeve Inc. 

3M®, Desco®, Richmond Technology®, and Plastic Systems® are registered trademarks. 

Neuron® and LonTalk® are registered trademarks of Echelon.

TosLink® is a registered trademark of the Toshiba Corporation.

Ethernet® is a registered trademark of the Xerox Corporation.

ENERGY STAR® is a registered trademark of the U.S. Department of Energy and the 
U.S. Environmental Protection Agency.

Other products mentioned herein may be the trademarks of their respective owners.

Lithium Batteries Notice

Switzerland requires the following notice for products equipped with lithium batteries. This notice is not 
applicable for all AMX equipment.

Upon shipment of products to Switzerland, the requirements of the most up-to-date Swiss Ordinance 
Annex 2.15 of SR 814.81 will be met including provision of the necessary markings, documents, and 
annual reports relative to the disposal of the batteries to the Swiss Authorities.

Warnings and Cautions

This manual uses the following conventions and icons to draw attention to actions or conditions that 
could potentially cause problems with equipment or lead to personal risk.

ESD Warning: The icon to the left indicates text regarding potential danger associated with the 
discharge of static electricity from an outside source (such as human hands) into an integrated 
circuit, often resulting in damage to the circuit.

Warning: The icon to the left indicates text that warns readers against actions or conditions that 
could cause potential injury to themselves.

Caution: The icon to the left indicates text that cautions readers against actions that could cause 
potential injury to the product or the possibility of serious inconvenience.
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Overview and General Specifications
Overview and General Specifications

Applicability Notice
The information in this manual applies to the following Epica DGX 144 enclosure and Epica DGX 144 
input and output boards:

Epica DGX 144 Enclosure (16 RU)

Epica DGX 144 Input and Output Boards

Each Epica DGX 144 system is custom built. The Epica DGX 144 boards that are currently available are 
listed in the charts below. Each board fills one slot. All boards have 16 connectors except for the DVI 
boards which each have 8 DVI-I and 4 DMS-59 connectors. The DMS-59 connectors break out to allow 
two DVI connections each for a total of 16 input or output channels per DVI board. 

A source connected to any of the input boards can be routed to any destination connected to any of the 
output boards. When routing from one board type to another, the Epica DGX 144 automatically converts 
the signal format to match the output board.

z For general board information, see page 12 and page 36.

z For specific board information, see the applicable board chapter, which is based on the 
supported signal type.

DGX SC Fiber Boards* (see page 45)

DGX HD-15 RGBHV Board (see page 51)

DGX DVI Boards (see page 59)

* DGX SC Fiber boards are used in conjunction with DGX SC Fiber Transmitter and Receiver modules. 
For system setup options with DGX SC Fiber boards and the modules, see page 20. For model numbers 
of the compatible modules, see page 46. For system setup information, see page 47. 

Configuration FG # Model

144x144 FG1055-11 AVS-EPDGX144-ENC

Type FG # Model

Input FG1055-440 AVS-EPDGX144-OI-SC

Output FG1055-450 AVS-EPDGX144-OO-SC

Type FG # Model

Input FG1055-480 AVS-EPDGX144-VI-HD15

 Type FG # Model

Input FG1055-460 AVS-EPDGX144-VI-DVI

Output FG1055-470 AVS-EPDGX144-VO-DVI
7Epica DGX 144 Instruction Manual



Overview and General Specifications
Product Notes
The Epica DGX 144 is available for custom systems in a variety of input to output configuration sizes and 
can contain an assortment of input and output boards in a single enclosure. An Epica DGX 144 enclosure 
fits in a broad range of digital and analog environments and is controllable from a variety of sources.

Note: Because the Epica DGX 144 Distribution Matrix is available in various board configurations, the 
illustrations in this manual may differ from the model(s) you purchased.

Features of the Epica DGX 144

z Available in input/output ranges from 16x16 to 144x144 in increments of 16 with configuration 
size upgrade potential.

z DGX Technology provides a common signal transport and matrix switching layer that 
transcodes between analog and digital signals.

z Supports uncompressed video resolutions up to 1920x1200 @ 60 Hz, including 1080p.
z AMX Device Discovery enabled through AMX’s AutoPatch Duet module.
z Designed for use with single strand multimode fiber.
z Use in conjunction with DGX SC Fiber Transmitters and Receivers to send video, audio, and 

one-way control over a single fiber cable up to 6,000 feet (1828.8 m) – 3,000 feet (914.4 m) to 
the Epica DGX 144 and 3,000 feet after the Epica DGX 144.

z Customizable with any combination of Epica DGX 144 SC Fiber input and output boards, DVI 
input and output boards, and HD-15 RGBHV input boards.

z SC Fiber boards support RGBHV, RGBS, RGsB, and Y/Pb/Pr (Y/Pb/Pr up to 1080p) video 
formats and DVI formats, depending on the type of DGX SC Fiber modules used with them.

z SC Fiber boards support embedded analog stereo audio signals (unbalanced stereo @ a sample 
rate of 48 kHz) and embedded digital audio signals (PCM over S/PDIF @ 32 kHz, 44.1 kHz, 
48 kHz, as well as 96 kHz, which requires a minimum 800x600 @ 60 Hz).

z SC Fiber boards also support unidirectional (source to destination) serial data.
z Compatible DGX SC Fiber Receivers feature SmartScale™ Technology which automatically 

responds to the display’s declared EDID information and scales the video to the best resolution 
and video parameters for that display without manual setup.

z Pre-loaded with the most common EDID settings on each matrix switcher input connector 
(other than fiber connectors) to emulate display response when queried, which makes sure 
transmission of the video from the source device is working.

z Custom EDID settings can be loaded on each DVI input or RGBHV input with the included 
EDID Programmer.

z System self-diagnostics (power monitoring, fan control and monitoring, signal and
temperature sensing); plus ships with free APDiagnostics software (monitors, display, collects 
advanced diagnostic information).

z Virtual matrices (levels) / groupings; ships with free matrix switcher configuration software.
z RJ-45 Ethernet (Enc Link) ports support linking to other AMX AutoPatch matrix switchers.
z Local presets allow quick recall of a pre-programmed set of switches with a single command; 

multiple presets can exist within a system at the same time.
z Global presets allow quick recall of a comprehensive snapshot of all switches.
z Standard RS-232 (Control) port.
z USB (mini-B) port can be used as a virtual Com port for serial communication with a PC.
z Fully redundant (hot-swappable) power supplies (RPS) with independent power paths for 

maximum reliability.
z Rack mounting ears integral to product design.
z AMX Limited Lifetime Warranty included (see www.amx.com or the AMX AutoPatch CD).
z 24-hour technical support.
8 Epica DGX 144 Instruction Manual



Overview and General Specifications
Control Features of the Epica DGX 144

Epica DGX 144 systems support the following two protocols: BCS* (Basic Control Structure) and 
XNNet.

Several control options are available for Epica DGX 144 systems. Multiple control methods can be used 
on the same system.

z Compatible with a number of AMX control devices (for control programming information, 
see the instruction manual for the specific interface)

z APControl 3.0 software (free with all systems) provides easy single-user PC control
z APWeb (TCP/IP control via an external module)
z Supports AMX AutoPatch’s simple BCS serial control protocol
z Supports third-party controllers

* BCS is sent as ASCII characters through the RS-232 port.

Note: Features and specifications described in this document are subject to change without notice.

Front View
The enclosure, which is the structural basis of the Epica DGX 144 Distribution Matrix, is custom built 
for each installation. The Epica DGX 144 enclosure is controlled using control software or an external 
controller (see page 14). The three LEDs on the front (FIG. 1) indicate status for power, redundant power 
supplies (RPS), and communication activity (see page 40).

FIG. 1  Front view of the Epica DGX 144 and front panel LEDs
9Epica DGX 144 Instruction Manual



Overview and General Specifications
Rear View
The enclosure’s appearance, as viewed from the rear (FIG. 2), will vary depending on the number and 
types of input and output boards present.  

Rear View Components

z Input and output boards (some slots may be empty, depending on the configuration)

z 3 expansion/control slots

z CPU/Control board

z Up to 4 power supplies with receptacles

z Serial number

Note: The Epica DGX 144 has a hand-hold inset on each side to assist with maneuvering the 
enclosure. Do not attempt to move the enclosure by yourself.

FIG. 2  Rear view of an Epica DGX 144 enclosure

Power supplies 

Serial number

Input boards (up to 9)

CPU/Control board

Output boards (up to 9)

Hand-hold inset

Expansion slots
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Overview and General Specifications
The following sections briefly introduce the hardware on the rear of the enclosure.

CPU/Control Board

The CPU/Control board (FIG. 3) is on the left rear of the enclosure, between the input connectors and the 
power supplies.

Each CPU includes the following port options:

z Control port (DB-9 serial) – for attaching an external control device (see page 31)

z USB (mini-B) port – for attaching an external control device (see page 33)

z Enc Link port (Ethernet RJ-45) – for linking to other types of enclosures (see page 23)

Two LED indicators are located on the far left side of the CPU/Control board:

z Communication Status Indicator – for Ethernet / linking communication activity

z System Status Indicator – for system status

Power Supply Units

Each power supply unit on the rear of the enclosure (FIG. 4) has a power receptacle that will accept 
all major international standard power sources. (US power cords are included with all shipments unless 
ordered otherwise.) Maximum power specifications are provided on the power supply receptacles. 
For information on applying power, see page 38.

The power supply unit has three LED indicators (listed left to right):

z AC ( ): When the LED is green, the power is good.

z DC ( ): When the LED is green, the power is good.

z Temperature ( ): When the LED is not illuminated, the temperature is good; when the LED 
is amber, the temperature is above normal.

Caution: Each power supply has a small toggle switch to the left of its LEDs that controls internal 
power and must remain flipped to the right for the system to operate. Do not flip this switch to the left.

FIG. 3  CPU/Control hardware

FIG. 4  Power supply receptacle, LEDs, and switch

USB (mini-B) port

Enc Link port 

Control (DB-9, RS-232 serial) portCommunication Status indicator
System Status indicator

(Ethernet RJ-45, 10/100),
used only for linking enclosures

Indicator LEDs

Leave switch on (flipped right)
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Overview and General Specifications
Expansion/Control Slots

Each enclosure has three expansion/control slots (FIG. 2 on page 10) for expansion boards to increase 
functionality and add new features to the system. If expansion boards are part of the original system, the 
boards are installed at the factory.

Input and Output Boards

A single enclosure can handle a combination of digital signals and analog signals, depending on the type 
of input and output boards. Digital signals can include: DVI-D, DVI-D over SC fiber, and embedded 
digital audio over SC fiber. Analog signals can include: RGBHV, RGBHV over SC fiber, and embedded 
analog audio over SC Fiber. The current selection of boards is listed on page 7.

Epica DGX 144 enclosures have 18 vertical board slots (9 slots each for input and output boards with 
16 channels per board), allowing for a maximum configuration of 144x144.

For information on the boards included in your system, including connector types, cabling directions, 
and specifications, see the specific board chapter in this manual.

For information on adding or replacing boards, see “Appendix E – Board Replacement” on page 97.

Input and Output Connectors

The connectors on the input and output boards are the attachment points for source and destination 
devices that connect to the system. Viewed from the rear of the enclosure, the input connectors (for 
attaching sources) are on the left, and the output connectors (for attaching destinations) are on the right.

Input and output channels (that correspond to the connectors) are numbered separately and read from top 
to bottom. The numbers for the channels are located on the metal to the left of each connector.

For important information on connecting to the DMS-59 connectors on the DVI input and output boards, 
see page 61.

FIG. 5  DGX SC Fiber, DGX DVI, and DGX HD-15 RGBHV input boards

DGX DVI input board

DGX HD-15 RGBHV input board

DGX SC Fiber input boards
12 Epica DGX 144 Instruction Manual



Overview and General Specifications
Serial Number

The serial number is normally located on the rear of the enclosure on the left (FIG. 2 on page 10). 
Before installation, we recommend recording the serial number for each enclosure in the system in an 
easily accessible location.

General Specifications

For individual board information and specifications, see the specific board chapter in this manual.

Note: Features and specifications described in this document are subject to change without notice.

Configuration Information and Control Options
The configuration file contains routing and control information for an AMX AutoPatch Routing System. 
Each system is programmed (configured) at the factory according to customer specifications.

Configuration Information

As shipped from the factory, the Epica DGX 144 supports full Device Discovery. The factory 
configuration contains two virtual matrices (VMs) for switching signals: VM 0 = all signals and VM 1 = 
video signals (in systems like the Epica DGX 144, by default both VMs route the same signals).

Note: When embedded audio is transmitted along with the video over the fiber, the audio switches 
on the same VM as the video (the audio and video cannot be switched independently).

The custom configuration file is provided on the AMX AutoPatch CD that is shipped with each system. 
XNConnect, the configuration software provided on the CD can be used to further customize the 
configuration file (see page 69).

Unless you need to modify your system, you will not need to use any of the configuration software that 
is included on the CD. If you do modify the configuration file, we recommend making a copy of it first.

Configuration file modifications include creating local presets, customizing input and output channel 
names for control display (e.g., in APControl 3.0 or APWeb’s control interface), as well as adding or 
managing hardware. Configuration file modifications are made with XNConnect, which graphically 
displays the AMX AutoPatch system and its control configuration. Other configuration software for 
specific hardware or for adjusting signal quality is also available on the AMX AutoPatch CD. For details, 
see the individual program’s Help file.

Specifications
Parameter Value

Approvals CE, UL, cUL, RoHS, FCC Class A
AC Power per Supply 100 VAC to 240 VAC single phase (50 Hz to 60 Hz)
Power Consumption (max.) 1563 Watts
Power Consumption (typical) 850 Watts, fully loaded enclosure
Thermal Dissipation (max.) 5333 BTU/hr.
Thermal Dissipation (typical) 2900 BTU/hr., fully loaded enclosure
Operational Temperature (continuous) 32° F to 110° F (0°C to 43° C)
Humidity 0 to 90% non-condensing
Dimensions 20.08 in. (51 cm) depth; 21.08 in. (53.54 cm) with extractors

19 in. (48.26 cm) width with rack mounting ears
17.6 in. (44.7 cm) width behind rack mounting ears
28 in. (71.1 cm) height (16 RU)

Weight Approximately 160 lb. (72.6 kg) per loaded enclosure
Shipping Weight Approximately 205 lb. (93 kg) per loaded enclosure
13Epica DGX 144 Instruction Manual



Overview and General Specifications
Control Options

Note: The Epica DGX 144 supports full Device Discovery through AMX’s AutoPatch Duet module 
(see page 77).

Epica DGX 144 enclosures can be controlled externally using one of the following options.

AMX Control Devices

The Epica DGX 144 is compatible with a number of AMX control devices. For control programming 
information, see the instruction manual for the specific interface.

Control Software 

Epica DGX 144 enclosures can be controlled using AMX AutoPatch software:

z APControl 3.0 – for control and scheduling

z Serial port located on the CPU
z Runs on a PC connected to the serial port
z Download from the AMX AutoPatch CD or from www.amx.com

z APWeb Server (TCP/IP) – for control, diagnostics, and third-party access

z Serial port located on the CPU
z Additional equipment is required
z Accessed through a TCP/IP interface, such as a web browser (e.g., Internet Explorer)
z Contact AMX regarding limitations and conditions for operating an Epica DGX 144 on a 

company LAN (Local Area Network)

Control Panel

If the Epica DGX 144 is linked to an Optima, Optima SD, Modula, or Modula CatPro that has a CP-10 
or a CP-20A Control Panel (local or remote), the panel can fully control the Epica DGX 144. When other 
types of AMX AutoPatch Control Panels are used to control the Epica DGX 144, some limitations apply. 
For specific control panel information, contact your AMX representative. For control panel operation, 
see the applicable product’s instruction manual.

BCS Serial Control Protocol

The Epica DGX 144 can be controlled with an external serial controller that sends and receives ASCII 
characters via the RS-232 serial port. AMX AutoPatch has developed a command language, BCS (Basic 
Control Structure) protocol, for programming control operations and for diagnostic purposes. BCS 
commands can be entered into a terminal emulation program (such as Windows® HyperTerminal) 
running on a PC. For information on BCS commands, see the Instruction Manual – BCS Basic Control 
Structure Protocol on the AMX AutoPatch CD or at www.amx.com.

Third-Party Controllers

A third-party controller can also be attached to an Epica DGX 144 enclosure via the RS-232 port. 
If using a third-party controller, see the controller documentation for operating instructions.

XNNet Protocol 

Advanced programmers who want to design their own control programs can use XNNet protocol. 
The AMX AutoPatch CD includes the XNNet Communication Library that supports C, Java, and 
Visual Basic with examples of the XNNet protocol in use.
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Overview and General Specifications
System Diagnostic Options
The two system diagnostic options for the Epica DGX 144 are APDiagnostics software and a 
programmer’s interface, which displays in a splash screen.

APDiagnostics

APDiagnostics is a software application that monitors and displays advanced diagnostic information 
about the Epica DGX 144. This application is available on the AMX AutoPatch CD or at www.amx.com. 
APDiagnostics also works with other AMX AutoPatch products that are capable of reporting such data. 
For information on APDiagnostics, see Appendix C on page 79.

Programmer’s Interface for System Diagnostics

The Epica DGX 144 displays system information in its splash screen for diagnostic purposes. The 
information indicates the current status and well-being of the system components. The splash screen can 
be accessed using a terminal emulation program, such as HyperTerminal. For information on the 
programmer’s interface, see Appendix D on page 93.
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Installation and Setup
Installation and Setup

UL Site Requirements
Warning: Per UL requirements – “This product must be installed within a restricted access location 
where access is through the use of a tool, lock and key, or other means of security, and is controlled 
by the authority responsible for the location. This product must be installed and maintained only by 
qualified technicians.”

The precautions in the Warning above are required due to accessible hazardous energy levels from the 
power supplies (greater than 240 W of available power). The energy levels are considered accessible 
because the input and output boards are removable by hand.

UL Safety Certifications, Notices, and Recommendations for Laser Products
Per UL requirements, note the following:

z The DGX Fiber boards comply with IEC Standard: IEC 60825-1, 2001.

z The boards also comply with 21 CFR 1040.10 and 1040.11 except for deviations pursuant
to Laser Notice No. 50, dated June 24, 2007. 

z The DGX TX Fiber boards are CLASS 1 LASER PRODUCTS.

z The maximum output power of the laser radiation is 4.08 mW.

Since the class of radiation emitted from the fiber port can be Class 3R when the fiber cable or dust plug 
is removed, a yellow and black label with the following caution is located on the rear of the enclosure to 
the right of the power supplies:

Important: No user serviceable parts are inside an AMX AutoPatch product; service should only be 
done by qualified personnel.

Caution: Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure. 

Exercise caution when installing DGX products to avoid direct eye exposure to invisible laser radiation.  
Follow the recommendations below whenever installing or working with DGX products.

T  Be sure to apply the power only after all fiber connections are made and no fiber ends are 
exposed. 

T  Do not remove dust plugs from SC fiber connectors or the dust caps from the fiber cables until 
establishing connections; avoid direct eye exposure.

T  Make sure all cables, including fiber cables, are correctly connected and/or terminated. 

T  Before you unplug a fiber cable on an input board, disconnect the power on the DGX TX that is 
connected to the input.

T  Before you unplug a fiber cable on an output board, disconnect the switch for that output 
connector.

FIG. 6  Caution label for Class 3R laser products
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Installation and Setup
Site Recommendations
When placing the enclosure, follow the recommendations and precautions in this section to reduce 
potential installation and operation hazards.

Environment
z Choose a clean, dust free, (preferably) air-conditioned location.
z Avoid areas with direct sunlight, heat sources, or high levels of EMI (Electromagnetic 

Interference).

Chassis Accessibility
Make sure the front and rear panels of the enclosure are accessible, so that you can monitor the LED 
indicators. Leaving adequate clearance at the rear will also allow for easier cabling and service.

Power
Important: For proper functioning, apply power to at least two power supplies simultaneously to the 
Epica DGX 144 before applying power to the system’s source and destination devices. We 
recommend attaching all power cords to a single surge protector (20 A) and/or an AC line 
conditioner.

The source’s electrical outlet should be installed near the router, easily accessible, and properly 
grounded. Power should come from a building branch circuit. We strongly recommend using a dedicated 
line for the system’s power. Use a minimum breaker current rating of 20 A for 110 V. 

To avoid an overload, note the power consumption rating of all the equipment connected to the circuit 
breaker before applying power.

General Hazard Precautions
The following recommendations address potential hazards that are common to all installations.

Elevated Operating Temperature
The maximum rated ambient temperature for Epica DGX 144 enclosures is 110° F (43° C).

All equipment should be installed in an environment compatible with the manufacturer’s maximum 
rated ambient temperature. In a closed or multi-unit rack assembly, the operating ambient temperature of 
the rack environment may be greater than the ambient room temperature.

Caution: To protect the equipment from overheating, do not operate in an area that exceeds 
110° F (43° C) and follow the clearance recommendation below for adequate airflow.

Airflow Restriction
Epica DGX 144 enclosures are designed to adequately dissipate the heat they produce under normal 
operating conditions; however, this design is defeated when high heat producing equipment is placed 
directly above or below an enclosure. 

Caution: To prevent overheating, avoid placing high heat producing equipment directly above or 
below the enclosure. The system requires a minimum of one empty rack unit above and below 
(three empty rack units are recommended). Verify that the openings on the top and sides of the 
enclosure are not blocked and do not have restricted air flow.

Mechanical (Rack) Loading
When installing equipment in a rack, distribute the weight to avoid uneven mechanical loading. 
Note that the Epica DGX 144 weighs approximately 160 pounds (72.6 kg) fully loaded.

Circuit Overloading
When connecting the equipment to the supply circuits, be aware of the effect that overloading the 
circuits might have on over-current protection and supply wiring.
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Installation and Setup
Reliable Earthing (Grounding)
Reliable earthing of rack-mounted equipment should be maintained. If not using a direct connection to 
the branch circuit (e.g., plugging into a power strip), pay particular attention to supply connections.

Caution: For proper start up, AC power must be applied to at least two of the enclosure’s power 
supply units at the same time. We strongly recommend attaching all of the power cords to a single 
surge protector (20 A) and/or an AC line conditioner. After powering up the enclosure, apply power 
to the source and destination devices.

Unpacking
The Epica DGX 144 is shipped with one enclosure per shipping box. The invoice is sent separately; 
a packing slip is attached to the outside of each box. Each box contains the following items:

T Enclosure on pallet
T Up to four standard US power cords (if shipped within the US)

T Other enclosure products, as needed

The documentation in the first box includes:

T AMX AutoPatch Epica DGX 144 Quick Start Guide

T AMX AutoPatch CD 

For orders containing multiple enclosures, the shipping boxes are marked as “Chassis __ of __,” where 
the first blank is the box number and the second blank is the total number of boxes in the shipment.

Important: If applicable, the shipping boxes each have a bright yellow/green sticker that states that 
the unit (enclosure) is part of a multiple-enclosure system and must be installed with the same serial 
numbers.

Unpacking Tips
T  Before fully unpacking the enclosure(s), inspect the shipping box(es) for any signs of damage. 

If a box is partially crushed or any sides have been broken open, notify the shipping 
agency immediately and contact your AMX representative (see the warranty on the 
AMX AutoPatch CD or at www.amx.com).

T  Once unpacking is complete, closely check the physical condition of the enclosure. 

T  Keep the enclosure on the pallet for easy maneuverability with a pallet jack or fork lift until 
the enclosure is installed.

T  Collect all documentation.

Note: Please save the original shipping container and packing materials. AMX is not responsible for 
damage caused by insufficient packing during return shipment to the factory. Shipping boxes are 
available; contact your AMX representative for details.
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System Setup Options
The following table contains system setup options for using DGX SC Fiber modules in conjunction with 
SC Fiber boards in an Epica DGX 144. For additional information, see page 47.

Note: In addition to the system setup options listed in the table above, optical signal flow between 
Epica DGX 16, 32, and 144 enclosures is supported. Contact your AMX representative for this 
and other system design possibilities. DGX SC Fiber modules can also be used in a standalone, 
end-to-end solution; see the “Instruction Manual – DGX Transmitters & Receivers.”

Rack Installation and System Setup
The Epica DGX 144 Distribution Matrix enclosure is mounted in a standard EIA 19 in. (48.26 cm) rack. 

Important: Placing an Epica DGX 144 in a rack requires a minimum of three people.

Required items for rack installation:
T   Enclosure

T   Standard EIA 19 in. (48.26 cm) rack

T Pallet jack or forklift

T   Screwdriver

T   Screws that fit your rack for mounting the enclosure(s)

T Power cords 

T Surge-protector(s) – highly recommended

T  A PC or laptop computer with a null modem cable (for communication with the 
Epica DGX 144 via the RS-232 serial port)

Installation Recommendations

T  Write the serial number (normally located on rear of enclosure) in an easily accessible 
location before installing the Epica DGX 144 in a rack.

T  Use an earth-grounded power cord / system with the Epica DGX 144.

T  Attach all power cords to a single surge protector (20 A) and/or an AC line conditioner.

T  Apply power to the Epica DGX 144 enclosure(s) before applying power to its source 
and destination devices.

System Setup Options – AMX AutoPatch Epica DGX 144 Boards with DGX Modules

DGX SC Fiber Module DGX Matrix Switcher 
Input Board

DGX Matrix Switcher 
Output Board

DGX SC Fiber Module

DVI TX SC Fiber SC Fiber DVI RX

DVI TX SC Fiber SC Fiber HD-15 RX

HD-15 TX SC Fiber SC Fiber DVI RX

HD-15 TX SC Fiber SC Fiber HD-15 RX

DVI TX SC Fiber DVI Not Applicable

HD-15 TX SC Fiber DVI Not Applicable

Not Applicable DVI SC Fiber DVI RX

Not Applicable DVI SC Fiber HD-15 RX

Not Applicable HD-15 RGBHV SC Fiber DVI RX

Not Applicable HD-15 RGBHV SC Fiber HD-15 RX
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Safety Recommendations for Laser Products

Important: No user serviceable parts are inside an AMX AutoPatch product; service should only be 
done by qualified personnel.

Caution: Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure. 

Exercise caution when installing DGX products to avoid direct eye exposure to invisible laser radiation.  
Follow the recommendations below whenever installing or working with DGX products.

T  Be sure to apply the power only after all fiber connections are made and no fiber ends are 
exposed. 

T  Do not remove dust plugs from SC fiber connectors or the dust caps from the fiber cables until 
establishing connections; avoid direct eye exposure.

T  Make sure all cables, including fiber cables, are correctly connected and/or terminated. 

T  Before you unplug a fiber cable on an input board, disconnect the power on the DGX TX that 
is connected to the input.

T  Before you unplug a fiber cable on an output board, disconnect the switch for that output 
connector.

Installation Flow Chart

To install and setup an Epica DGX 144:

Warning: This product must be installed within a restricted access location where access is through 
the use of a tool, lock and key, or other means of security, and is controlled by the authority 
responsible for the location. This product must be installed and maintained only by qualified 
technicians (see page 17).

1. Install the Epica DGX 144 enclosure in a rack (see page 22).

2. If applicable – For multiple-enclosure systems, link them according to the instructions provided 
(see page 23).

Caution: On systems with SC Fiber boards, we recommend using the provided cable management 
bars or some other type of cable management system to avoid damage to the fiber cables.

3. If applicable – For systems with SC Fiber boards, install cable management bars (see page 23).

CAUTION: CLASS 3R INVISIBLE LASER RADIATION WHEN OPEN; AVOID DIRECT EYE 
EXPOSURE.

4. Attach only the first two source and destination devices (see page 36). 

5. If applicable – For boards that require DGX SC Fiber modules, you will also need to install them for 
the first two source and/or destination devices (see the module’s documentation).

6. Attach the external control device (see page 30).

7. Attach power cords to all power receptacles on each enclosure, then turn on the entire system 
(see page 38). We recommend using a single surge protector (20 A) and/or an AC line conditioner.

8. Execute a test switch to be sure the system is working properly (see page 41).

9. When the test switch works correctly, attach the remaining source and destination devices and any 
additional DGX SC Fiber modules.

FIG. 7  Installation procedure

Install 
in rack

If multiple - 
enclosure 
system, link 
enclosures

Attach 
controller

Attach 1st two input 
and output cables; 
if applicable, install 
the DGX SC Fiber 
modules

Apply power 
to enclosure(s)
and then to 
system devices

Execute 
test switch

Attach all input 
& output cables
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Software (Located on the AMX AutoPatch CD and at www.amx.com)
z EDID Programmer software is used for re-programming the DVI or the HD-15 RGBHV input 

boards if necessary (see page 63). 

z For some signals, board configuration software is used to adjust the source signal for optimal 
display (for information on the DG_HD15 Wizard, see page 54).

For information on other types of board configuration software, see the DGX SC Fiber module’s 
documentation.

Additional Setup
Additional setup tasks may include creating the following:

z Local Presets and/or Custom Channel Names – See “Appendix B – Managing Configuration 
Files” on page 74.

z Global Presets – See the Instruction Manual – BCS Basic Control Structure Protocol on the 
AMX AutoPatch CD or at www.amx.com.

Rack Installation

Caution: To prevent overheating and airflow restriction, avoid placing high heat producing 
equipment directly above or below the enclosure. The system requires a minimum of one empty rack 
unit above and below (three empty rack units are recommended). Verify that the openings on the top 
and sides of the enclosure are not blocked and do not have restricted air flow.

The Epica DGX 144 has a hand-hold inset on each side to assist with maneuvering the enclosure. Do not 
attempt to lift the enclosure from the pallet to the rack by yourself.

Important: Do not use the board extractor handles to lift the enclosure or to maneuver it into place. 
Use a pallet jack to lift it, and use the hand-hold insets on the sides of the enclosure to maneuver it.

To install an enclosure in a rack (requires a minimum of 3 people):

1. While the enclosure is still on the pallet, cut loose and remove the outer straps.

2. Remove the tray (contains cables, etc.) from the top of the cardboard sleeve.

3. Remove the cardboard sleeve.

4. Cut loose and remove the inner straps. Carefully remove the shrink-wrap and corner cushions.

5. Use a pallet jack to move the enclosure into position.

6. Select a position in the rack that is accessible and does not restrict airflow (see Caution above).

7. Lift and push the enclosure into the rack. Screw in the top 3 rack ear screws on each side.

8. Move the pallet jack out of the way. Supporting the enclosure as needed, screw in the remaining 
rack ear screws.
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Attaching Cable Management Bars

AMX AutoPatch cable management bars are provided for SC Fiber input and output boards.

Caution: Do not severely bend or kink the SC fiber cable. Irreversible damage can occur. Refer to 
the physical limitations (bend radius) specified for the cable by the manufacturer. The bend radius 
for AMX SC terminated fiber cables is 2 inches (5 cm).

To install cable management bars:

1. Align the two screw holes on the end of the cable management bar with the two screw holes at the 
top of the board as shown at left in FIG. 8. (Note that the long part of the bar is left of the holes.)

2. Insert and tighten the two screws at the top of the cable management bar (do not over tighten).

3. Insert and tighten the two screws at the bottom of the cable management bar (do not over tighten).

Linking Enclosures
An Epica DGX 144 enclosure can be linked to other types of AMX AutoPatch Distribution Matrices by 
using its Ethernet (10/Base-T) port which is labeled Enc Link. Linking from an Epica DGX 144 
enclosure to another Epica DGX 144 (or to an Epica DG) enclosure is currently not supported.

Important: The shipping boxes each have a bright yellow/green sticker that states that the unit 
(enclosure) is part of a multiple-enclosure system and must be installed with the same serial 
numbers.

Linking enclosures allows control information to pass between them. In a multiple-enclosure system, the 
enclosure with a control panel or with an external controller attached receives control information and 
passes on relevant information to the other enclosures via the links, as well as retrieving control request 
for success/failure from each of them.

Caution: AMX AutoPatch systems should only be linked in their own isolated networks.

If any of the linked enclosures were not part of the original system, contact technical support
(see page 43) for important information not included here.

FIG. 8  Install cable management bars

Fasten cable management 
bar with two screws at top 
and two at bottom

Tie cable to cable management
bar far enough below connector
to allow for manufacturer’s 
recommended bend radius
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Enclosures and Ethernet Connectors

The method used for linking depends on the type of Ethernet connector on each enclosure’s CPU. 
The table below indicates the type of Ethernet connectors available on AMX AutoPatch enclosures.

* The RJ-45 port is labeled “Link” on some enclosures and “Enc Link” on others.

Link Cables and Equipment

AMX provides link cables and equipment for enclosures that are ordered as part of a linked system. 
Linking from one Epica DGX 144 enclosure to another Epica DGX 144 (or an Epica DG) enclosure is 
currently not supported, but the Epica DGX 144 can link to other AMX AutoPatch Distribution Matrices 
using the cable and equipment specified in the table below. A Multi-Port (8 or 5) Switch is also provided 
for some types of multiple-enclosure systems.

Link Cables and Equipment List

z RJ-45 Crossover Cable: use to connect 10Base-T enclosures to a Media Converter or 
to a Multi-Port Switch; also used for direct linking between 10Base-T enclosures. 
The cable is wired to TIA/EIA-568-A on one end and TIA/EIA-568-B on the other end.

z RJ-45 Straight-Through Patch Cable: use to connect a 10Base-T enclosure to 
a Media Converter or to a Multi-Port Switch. Both ends of the cable are wired to 
TIA/EIA-568-A.

z RG-58 Coax Cable: use to connect a 10Base-2 (BNC) enclosure to a Media Converter; also 
used to daisy chain 10Base-2 enclosures.

z Media Converter: use when linking 10Base-T (RJ-45) enclosures to 10Base-2 (BNC) 
enclosures.

z Multi-Port Switch: use when linking some types of multiple-enclosure systems.

Enclosure Ethernet 10Base-T* (RJ-45) Ethernet 10Base-2 (BNC)

Epica DGX 144

Epica DGX 16/32

Epica-128 and Epica-256

Modula and Modula CatPro

Optima and Optima SD

Precis SD

Link Cable and Equipment for Epica DGX 144 Linked Systems

Enclosure Cable Converter Cable Enclosure

Epica DGX 144 RJ-45 straight-through patch Media Converter RG-58 coax Epica-128 or Epica-256

Epica DGX 144 RJ-45 crossover – – Epica DGX 16/32

Epica DGX 144 RJ-45 straight-through patch Media Converter RG-58 coax Modula or Modula CatPro

Epica DGX 144 RJ-45 crossover – – Optima or Optima SD

Epica DGX 144 RJ-45 crossover – – Precis SD

Epica DGX 144 -------------- Linking currently not supported -------------- Epica DGX 144 or 
Epica DG
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Ethernet Connector LEDs

The Enc Link, 10Base-T Ethernet (RJ-45), connector on the Epica DGX 144 has two LEDs that indicate 
communication status when the enclosure is linked to an active system.

The LEDs indicate the following:

z Green LED on – speed status is 100 Mbps

z Green LED off – speed status is 10 Mbps

z Amber LED on – link status is active

Note: The Comm (Communication Status) indicator at the top left of the CPU indicates if Ethernet 
traffic is on the system by blinking green.

FIG. 9  Ethernet connector LEDs

Green LED – Speed Status

Amber LED – Link Status
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Linking Epica DGX 144 to Enclosure with 10Base-T Ethernet Port

An Epica DGX 144 can be directly linked to an Optima, Optima SD, Precis SD, and Epica DGX 16/32 
enclosures via their Ethernet 10Base-T (Link) ports using an RJ-45 crossover cable.

Important: If the system has an RJ-45 connector labeled TCP/IP, do not use it for linking 
enclosures. Do not use an RJ-45 enclosure linking connector for a TCP/IP connection.

Cable Length Requirements

To link an Epica DGX 144 to an enclosure with a 10Base-T Ethernet port:

1. Insert the connector on one end of the RJ-45 crossover cable into the Epica DGX 144 enclosure’s 
Enc Link / RJ-45 port.

2. Insert the connector on the other end of the crossover cable into the Ethernet 10Base-T / RJ-45 port 
on the second enclosure’s CPU.

When power is applied, the Ethernet connector LEDs illuminate indicating communication status
(see page 25).

Network Segment Cable Type Max. Distance

Epica DGX 144 to Optima, Optima SD, Precis SD, or Epica DGX 16/32 RJ-45 crossover 100 ft. (30.5 m)

FIG. 10  Epica DGX 144 linked to an Optima using RJ-45 crossover cable

RJ-45 crossover cable
Max. 100 ft. (30.5 m)
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Linking Epica DGX 144 to Enclosure with 10Base-2 Ethernet Port

An Epica DGX 144 enclosure can be linked to an enclosure with an Ethernet 10Base-2 connector 
(Modula, Modula CatPro, Epica-128, or Epica-256) by using a Media Converter. Additional Ethernet 
10Base-2 enclosures can be daisy-chained off the first one.

Important: If the system has an RJ-45 connector labeled TCP/IP, do not use it for linking 
enclosures. Do not use an RJ-45 enclosure linking connector for a TCP/IP connection.

Cable Length Requirements

Important: Attach 50-ohm termination connectors to the open ends of the T-connectors on the 
Media Converter and on the last enclosure of the cable run.

To link an Epica DGX 144 to an enclosure with a 10Base-2 Ethernet port:

1. Insert the RJ-45 straight-through patch cable into the Epica DGX 144 enclosure’s Enc Link / RJ-45 
port.

2. Insert open end of the cable into the Media Converter’s 10/100 / RJ-45 port.

3. Fasten a T-connector to the Media Converter’s BNC connector.

4. Attach an RG-58 coax cable to the T-connector.

5. Add a 50-ohm termination connector to the open end of the T-connector.

6. Fasten a T-connector to the Ethernet 10Base-2 / BNC connector on the second enclosure’s CPU.

7. Attach the open end of the RG-58 coax cable to the T-connector.

8. If applicable – Attach additional enclosures with T-connectors and RG-58 coax cables.

9. Add a 50-ohm termination connector to the open end of the T-connector on the last enclosure of the 
cable run.

When power is applied, the Ethernet connector LEDs illuminate (see page 25).

Network Segment Cable Type Maximum Distance

Epica DGX 144 to Media Converter RJ-45 straight-through patch 100 ft. (30.5 m)

Media Converter to last enclosure in daisy chain RG-58 coax 10 ft. (3.05 m) total

FIG. 11  Epica DGX 144 linked to a Modula using a Media Converter

The total length of all cables between 
the Media Converter and the last 
enclosure in a daisy chain cannot 
exceed 10 ft. (3.05 m).RG-58 coax cable

Max. 10 ft. (3.05 m)

50-ohm termination connector

Straight-through patch cable
Max. 100 ft. (30.5 m)

Media Converter
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Linking More Than Two Enclosures

Linking an Epica DGX 144 enclosure to multiple other types of enclosures (other than linking in a daisy 
chain off an enclosure with a 10Base-2 / BNC connector) requires a Multi-Port Switch and RJ-45 
straight-through patch cables. Depending on the other types of enclosures, a Media converter(s) and 
RG-58 coax cable(s) may also be required. FIG. 12 below shows an Epica DGX 144 enclosure linked to 
an Optima and to a Modula using a 5-Port Switch and a Media Converter.

Important: If the system has an RJ-45 connector labeled TCP/IP, do not use it for linking 
enclosures. Do not use an RJ-45 enclosure linking connector for a TCP/IP connection.

Cable Length Requirements

Note: If you have questions regarding cabling or network related issues in conjunction with using a 
Multi-Port Switch (or hub) for linking enclosures, contact your network administrator.

When attaching multiple enclosures to a Multi-Port Switch, one or more can be connected directly to 
the Multi-Port Switch (see steps below) and/or one or more can use a Media Converter to connect to 
the Multi-Port Switch (see steps on page 29). In a system with multiple 10Base-2 enclosures, only one 
needs to be attached to the Multi-Port Switch with a Media Converter. The rest can be daisy-chained.

To link an Epica DGX 144 enclosure to a Multi-Port Switch:

1. Insert one end of the RJ-45 straight-through patch cable into the Enc Link (RJ-45) Ethernet port on 
the Epica DGX 144 enclosure.

2. Insert the other end of the RJ-45 straight-through patch cable into the Multi-Port Switch.

3. Repeat Steps 1 and 2 for enclosures with 10Base-T ports.* For 10Base-2 ports, go to page 29.

* Applies when linking an Optima, Optima SD, Precis SD, or Epica DGX 16/32 to a Multi-Port Switch.

Important: Attach 50-ohm termination connectors to the open ends of the T-connectors on the 
Media Converter and on the last enclosure on the cable run.

Network Segment Cable Type Maximum Distance

Epica DGX 144 to Multi-Port Switch RJ-45 straight-through patch 100 ft. (30.5 m)

Multi-Port Switch directly to another type enclosure RJ-45 straight-through patch 100 ft. (30.5 m)
Multi-Port Switch to Media Converter RJ-45 straight-through patch 100 ft. (30.5 m)
Media Converter to last enclosure in daisy chain RG-58 coax 10 ft. (3.05 m) total

FIG. 12  Epica DGX 144 enclosure linked to an Optima and a Modula

The total length of all cables between the 
Media Converter and the last enclosure in a 
daisy chain cannot exceed 10 ft. (3.05 m).

Straight-through patch cable - max. 100 ft. (30.5 m) each cable

RG-58 coax cable
Max. 10 ft. (3.05 m)

Media Converter

5-Port Switch

50-ohm termination connectors

Link 

Link Modula

(See steps above)

(See steps

Link Optima
(See steps above)

on next page)

Epica DGX 144
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To link enclosures* with 10Base-2 Ethernet connector to Multi-Port Switch:

1. Fasten a T-connector to the Ethernet BNC connector on the enclosure’s CPU.

2. Attach an RG-58 coax cable to the T-connector.

3. If applicable – Attach additional enclosures with T-connectors and RG-58 coax cables.**

4. Add a 50-ohm termination connector to the open end of the T-connector on the last enclosure of the 
cable run.

5. Fasten a T-connector to the Media Converter’s BNC connector.

6. Attach the open end of the RG-58 coax cable to the T-connector on the Media Converter. 

7. Add a 50-ohm termination connector to the open end of the T-connector on the Media Converter.

8. Insert one end of the RJ-45 straight-through patch cable into the 10/100 (RJ-45) Ethernet port on the 
Media Converter.

9. Insert the other end of the RJ-45 straight-through patch cable into the Multi-Port Switch.

When power is applied to the enclosures, the Ethernet connector LEDs illuminate indicating 
communication status (see page 25).

* Applies to Modula, Modula CatPro, Epica-128, and Epica-256 enclosures.

** The total length of all RG-58 coax cables between the Media Converter and the last enclosure in the 
daisy chain cannot exceed 10 ft. (3.05 m).
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Attaching External Controllers
The Epica DGX 144 can be controlled externally by attaching a control device that uses one of the 
communication protocols listed below:

z BCS (Serial) – ASCII sent over a null modem serial cable via the serial port

z BCS (USB) – ASCII sent over a USB cable via USB (Mini-B) port used as a virtual Com port

z XNNet – AMX AutoPatch protocol via the serial port

Important: The Ethernet (Enc Link) connector is not a TCP/IP interface and is used primarily for 
linking enclosures (see page 23).

Control Options

The communication protocols listed above are used for these control options:

AMX Control Devices

The Epica DGX 144 is compatible with a number of AMX control devices (for control programming 
information, see the instruction manual for the specific interface).

APControl 3.0

APControl 3.0 software (for control and scheduling) runs on a PC connected to an Epica DGX 144 via 
the serial port (DB-9) or the USB (Mini-B) port and is available on the AMX AutoPatch CD. 
APControl 3.0 has a setup wizard that can discover the system’s configuration information.

APWeb (TCP/IP)

The APWeb Server (for control, diagnostics, and third-party access) is accessed through a TCP/IP 
interface, such as a web browser (e.g., Internet Explorer). The Epica DGX 144 serial port (DB-9) is used 
to access APWeb. Additional equipment is required for APWeb. For setup and operation information, 
see the Instruction Manual – APWeb on the AMX AutoPatch CD and at www.amx.com.

Important: Contact AMX regarding limitations and conditions for operating an Epica DGX 144 on a 
company LAN.

XNNet Protocol (Serial)

Advanced programmers who want to design their own control programs can use AMX AutoPatch 
XNNet protocol. The AMX Autopatch CD includes the XNNet Communication Library, an interface 
library that supports C, Java, and Visual Basic with examples of the XNNet protocol in use.

BCS (Serial) Control

AMX AutoPatch has developed a command language, BCS (Basic Control Structure), for executing 
control operations and for diagnostic purposes. BCS commands are issued via a terminal emulation 
program, such as HyperTerminal. For information on BCS commands, see the Instruction Manual – BCS 
Basic Control Structure Protocol on the AMX AutoPatch CD or at www.amx.com.

Third-Party Controllers (Serial)

Third-party controllers connect to the serial port (DB-9) or USB (Mini-B) port on the CPU. If using a 
third-party controller, see the controller documentation for setup and operating instructions.
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Connecting Serial Controllers

An external serial controller is any device that can send and receive ASCII code over an RS-232 
(null modem) or RS-422 serial cable attached to the serial port (DB-9) on the enclosure’s CPU. PCs are 
common serial controllers. Once a PC is attached to the Epica DGX 144, the system can be controlled by 
running APControl 3.0 software on the attached PC (see the AMX AutoPatch CD). The system can also 
be controlled by entering BCS commands into a terminal emulation program (e.g., HyperTerminal). 

PC Requirements for APControl 3.0
T  Windows® XP Professional or Windows® 2000 
T  Java Runtime Environment (JRE):  v1.4.2 or the latest version
T  Minimum Hardware:  166 MHz, 128 MB RAM, 20 MB free disk space, 800x600 display
T  Recommended Hardware:  2.0 GHz, 512 MB RAM, 20 MB free disk space, 

1280x1024 display
T  Serial port or USB port

PC Requirements for BCS
T  Windows® XP Professional or Windows® 2000 
T Terminal emulation program
T  Serial port or USB port (for USB serial control information, see page 33)

Connecting Serial Controllers to DB-9 Port

The RS-232 cable pinout is in FIG. 14 on page 32, and the RS-422 cable pinout is in FIG. 15 on page 33.

To establish external serial control:

1. RS-232 serial cable (null modem) – Plug one end of the null modem serial cable into the serial port 
(DB-9) on the enclosure.
Or
RS-422 serial cable (requires reconfiguring the DB-9 serial port) – Establish a serial connection 
with a PC using the USB port (FIG. 13). Install and open XNConnect. Select File > Discover 
System. In the Hardware view, right-click the serial port icon and select Change Settings. On the 
Modify Serial Port drop-down menu select: Mode > RS-422 Character (unless directed by technical 
support to use RS-422 Block). Click Download; click OK. From the Configure menu, select Reboot 
All Devices. Plug the RS-422 serial cable into the serial port (DB-9) on the enclosure.**

** After a serial port is configured for RS-422 cable, do not attach an RS-232 cable without first 
reconfiguring the port in XNConnect.

FIG. 13  Connect to serial port

Control (serial) port

Cable to serial control device / system
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serial
table
2. Plug the other end of the serial cable (RS-422 uses platform specific pinout) into the serial port on 
the serial controller.

3. If not already on, apply power first to the Epica DGX 144 enclosure and then to the source and 
destination devices (see “Applying Power and Startup” on page 38).

Caution: To avoid system damage, follow the power-up sequence on page 38. We recommend 
attaching all power cords to a single surge protector (20 A) and/or AC line conditioner.

4. Setup and run the desired method of control:
AMX control devices – For control programming information, see the instruction manual for the 
specific interface.
APControl 3.0 – Install and open the latest version of the program (located on the AMX AutoPatch 
CD). Follow the setup wizard, which will discover the system’s configuration information and open 
the APControl Launchbar.
HyperTerminal (terminal emulation) – Open the program 
(typically at start/Programs/Accessories/Communications/
HyperTerminal), select the Com port, and set the settings to match the 
default ones in the Epica DGX 144 Serial Port Settings table to the 
right. Click OK. A short splash screen appears.

5. Execute a test switch to be sure the Epica DGX 144 is working 
properly (see “Executing a Test Switch” on page 41).

Serial Communication Settings

When controlling the system with a serial controller, use serial communication software and make sure 
the baud rate is set correctly for the system. The recommended (default) settings for serial 
communication with an Epica DGX 144 Distribution Matrix are provided in the table above. These 

enclosures support baud rates of 9600 (default), 19200, 38400, and 57600. The settings on the PC serial 
communication software and the enclosure must correspond to each other. If a change is required to 
make them match, changing the PC’s settings is preferable. If you decide to change the enclosure’s 
settings instead, use XNConnect (see the Help file).

RS-232 Pin Diagram

Use a null modem cable that matches the pin diagram in FIG. 14 for RS-232 without hardware flow 
control. AMX AutoPatch equipment requires pins 2, 3, and 5 only. 

RS-232 Pin Diagram

FIG. 14  RS-232 null modem cable pin diagram, no hardware flow control

AutoPatch: DB-9
PC: DB-9

Epica DGX 144
Serial Port Settings

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1

Flow Control None

 port settings 
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RS-422 Pin Diagram

Use a cable that matches the pin diagrams in FIG. 15 for RS-422, and change the settings in the 
configuration file per Step 1 on page 31.

RS-422 Pin Diagram

Connecting Serial Controllers to USB Port

Controlling the Epica DGX 144 using a USB connection requires the creation of a virtual Com port. 
Once created, the virtual Com port is used as though it was a standard serial connection and can connect 
to a control application (such as APControl 3.0) or to a terminal emulation program (such as Windows® 
HyperTerminal) for BCS control.

Important: You must have adequate rights to install USB device drivers to the PC. Check with your 
System Administrator to be sure you have the required access.

When establishing a new connection, complete all of the steps in the instructions starting below.

Or
When reconnecting after previously establishing a USB connection, complete Steps 1 and 2 and then 
set up and run the desired software program or utility.

The following steps apply when you use the AMX AutoPatch CD that shipped with the system. Using the 
default selections, the Found New Hardware Wizard searches for and installs the software. 

Note: If for any reason the Wizard does not automatically install the software, APBridge.inf is located 
on the AMX AutoPatch CD (<CDDrive>:\Configuration\APConfig\USB) and on the AMX website 
(go to www.amx.com and enter APBridge.inf in the Search AMX.com field in the upper right-hand 
corner of the site).

To attach a PC to the USB (Mini-B) port and establish a virtual Com port:

1. Apply power to the Epica DGX 144 (see page 38).

2. Connect the Epica DGX 144 to a PC running Windows® using a USB mini-B cable (FIG. 16).

FIG. 15  RS-422 cable pin diagram

FIG. 16  Connect to USB port

Cable to PC

USB (Mini-B) port
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3. If establishing a new connection, complete the remaining steps.
Or
If reconnecting after previously establishing a USB connection, go to Step 5 of identifying the 
virtual Com port on page 35 to run the control program.

Note: The following dialog boxes appear only during the initial USB connection. Once the virtual 
Com port has been assigned to the Epica DGX 144, the dialog boxes do not appear again. If they do 
appear, you have connected the USB plug to a different Com port than the initial one – either switch 
to the initial Com port or establish a virtual Com port for the new port on the PC.

The Found New Hardware notice window appears briefly. The Hardware Wizard will refer to the  
virtual Com port used by the Epica DGX 144 as an “AutoPatch USB Bridge” or “USB Device.”

The Found New Hardware Wizard opens.

Note: The dialog boxes may differ slightly from those shown here, depending on the operating 
system.

4. Insert the AMX AutoPatch CD into the PC’s CD holder.

5. Click Next.

6. Click Finish when prompted to close the Wizard.

You must identify the virtual Com port assigned to the USB connector to enable communication between 
the control PC and the Epica DGX 144; see the instructions on the next page.

Important: Before you start the following procedure, the enclosure must be connected to the PC via 
the USB port and powered up so that the PC can display the port number.

Virtual Com port
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To identify the virtual Com port:

1. Open the Windows® Device Manager (Start/Settings/Control Panel/System/System Properties/
Hardware tab/Device Manager button) and expand Ports by clicking on the “+”.
(The Device Manager may have a different location depending on the operating system and theme 
selected.)

2. If the port specifies the Com number, go to Step 4.
If the port does not specify the Com number, right-click AutoPatch USB Bridge, select Properties, 
and complete all remaining steps.

3. In the AutoPatch USB Bridge Properties dialog box, select the General tab.

4. Note the Com port assigned to the AutoPatch USB Bridge. This port number must be entered when 
setting a connection in a software program or a terminal emulation program. The PC will always 
associate a specific USB connector with the assigned virtual Com port. The PC will not recognize 
the Epica DGX 144 if you disconnect and reconnect using a different Com port on the PC. However, 
it will attempt to install a new virtual Com port using the new port. If completed, the new port will 
be assigned a different Com number.

5. Set up and run the desired method of control:
AMX control devices – For control programming information, see the instruction manual for the 
specific interface.
APControl 3.0 – Install and open the latest version of the program (located on the AMX AutoPatch 
CD). Follow the setup wizard, which will discover the system’s configuration information and open 
the Launchbar.
Terminal emulation – Open the program. Check to be sure the Communications Port option is set 
for the port determined in Step 3 above. Set the settings to match the default ones in the 
Serial Port Settings table on page 32. Click OK. A short splash screen appears.

6. Execute a test switch to be sure the Epica DGX 144 is working properly (see “Executing a Test 
Switch,” page 41).

Note: If power is cycled, the USB connection must be reestablished. Remove the USB cable and 
close the software application in use. Then reconnect the USB cable to the same USB connector 
used previously and reopen the communication software. 

Assigned port number
(if not displayed, complete
all remaining steps)

Com port number to enter when setting
connection in terminal emulation program
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Attaching Inputs and Outputs
Input and output connectors are the attachment points for source and destination devices that connect to 
the system. Epica DGX 144 enclosures have 18 vertical board slots (9 slots each for the input and the 
output boards with 16 channels per board), allowing for a maximum configuration of 144x144. Viewed 
from the rear of the enclosure, the input boards (for attaching sources) are on the left, and the output 
boards (for attaching destinations) are on the right.

Connectors and Input and Output Channels

Epica DGX 144 board types, their connector types, and the number of available input and output 
channels per board are listed in the table below.

* DMS-59 connectors are numbered for two breakout channels each.

Because some connectors are capable of routing multiple input or output 
channels, the channels are numbered rather than the connectors. The input or 
output channel numbers are to the left of the connectors and read from top to 
bottom. Numbering is consecutive for inputs; outputs start over at 1 and 
follow the same pattern. Boards are allocated 16 channels each.

For board connector information and specifications, see the specific board chapter in this manual:

z SC Single Fiber input and output boards – see page 45

z HD-15 RGBHV input board – see page 51

z DVI input and output boards – see page 59

Board/Signal Type # and Type of Connectors # Input and Output 
Channels

SC Fiber 16 SC Fiber 16 (input and output)

DVI / DVI-D 8 DVI-I
4 DMS-59*

8 (input and output)
8 (input and output)

RGBHV 16 HD-15 16 (input only)

FIG. 17  Numbers indicate input or output channels
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Attaching Cables

Cable Management Bars

If AMX AutoPatch cable management bars are used, they need to be installed before cables are attached.

Caution: Do not severely bend or kink the SC fiber cable. Irreversible damage can occur. Refer to 
the physical limitations (bend radius) specified for the cable by the manufacturer. The bend radius 
for AMX SC terminated fiber cables is 2 inches (5 cm).
 

Input and Output Signal Cables

Before connecting all input and output cables, attach only the first two input and output cables (and any 
applicable DGX SC Fiber modules) and execute a test switch (see page 41). When the test switch is 
successful, attach the rest of the input and output cables.

Note: The DMS-59 connectors support multiple channels (see FIG. 19). The configuration file and 
the internal pathways define each DMS-59 connection as two discrete signal paths for routing.

For information on cabling specific types of connectors, see the specific board chapter in this manual.

FIG. 18  AMX AutoPatch Epica DGX 144 cable management bars

FIG. 19  DMS-59 connectors on a DVI board support multiple I/O channels

Fasten cable management bar
with two screws at top and two
at bottom

Tie cable to cable management
bar far enough below connector
to allow for manufacturer’s
recommended bend radius

The DVI connectors on the DMS-59 breakout cable 
are labeled 1 (bottom connector) and 2 (top connector) 
and route signals that correspond to the numbering to 
the left of the DMS-59 receptacle on the enclosure:
• 1 for the number with the lower numerical value
• 2 for the number with the higher numerical value

DMS-59 connectors (two channels each)
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Applying Power and Startup
The enclosures’s universal power receptacles will accept all major international standard power sources. 
(Standard US power cords are included with all shipments unless ordered otherwise.) Maximum power 
specifications are on the power receptacle (also listed on page 13). Always use an earth-grounded power 
cord / system with an Epica DGX 144.

The source electrical outlet should be installed near the Epica DGX 144, easily accessible, and properly 
grounded. Power should come from a building branch circuit. We strongly recommend using a dedicated 
line for the system’s power. Use a minimum breaker current rating of 20 A for 110 V. To avoid an 
overload, note the power consumption rating of all the equipment connected to the circuit breaker before 
applying power.

Important: For proper functioning, apply power simultaneously to at least two power supplies on the 
Epica DGX 144 before applying power to the system’s source and destination devices. We 
recommend attaching all power cords to a single surge protector (20 A) and/or an AC line 
conditioner.

Power-Up Sequence

To apply power simultaneously to power supplies:

1. Attach the first two source and destination devices. 
Do not apply power to the source and destination devices until Step 7. 

2. Plug a power cord into each power receptacle on the enclosure.

3. Plug the other end of each power cord into a power strip that is turned off (we recommend using a  
20 A power strip on a 110 circuit).

4. Turn on the power strip. Check the Indicator LEDs on the front and rear of the enclosure. 
The indicator LEDs may take some time before they illuminate while the system runs its self-
diagnostics.

5. Attach the external control device/system (see page 31).

6. Apply power to the external control device/system. 

7. Apply power to the source and destination devices. 
The system is ready for a test switch (see page 41).

For startup information on specific types of control, see page 39 before executing a test switch.

Caution: Each power supply has a small toggle switch to the left of its LEDs that controls internal 
power and must remain flipped to the right for the system to operate. Do not flip this switch to the left.

FIG. 20  Attach power cables to each power receptacle
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Indicator LEDs

When the enclosure powers up, the indicator LEDs will respond as follows:

Important: If the indicator LEDs do not respond with a normal display as stated above, check all 
power connections before contacting technical support (see page 43).

* IOS (Initial Operating System) is the base layer operating system on AMX AutoPatch equipment. IOS performs 
functions such as hosting higher level run-time software applications. When unexpected critical errors are 
encountered within such hosted applications, system control of the equipment may be passed to the IOS layer 
preventing normal system operation until the error is manually cleared. Please report all such errors to AMX 
AutoPatch technical support (see page 43).

Powering Down
Important: When the system is powered down, be sure the indicator LEDs on the CPU are off and 
the fans have stopped before reapplying power.

The system is ready to disconnect the factory default switch and to execute a test switch (see page 41) 
using the control method of your choice. 

Serial Control Device Startup

If you have not already done so, attach the serial control device to the enclosure (see page 30) and open 
the control program.

AMX Control Devices
The Epica DGX 144 is compatible with a number of AMX control devices (for control programming 
information, see the instruction manual for the specific interface)

APControl 3.0
If you are using APControl 3.0, install and open the latest version of the program. Follow the directions 
in the setup wizard. As part of the setup wizard, APControl 3.0 will discover the system’s configuration 
information. From the Launchbar menu, select Views / CrossBar and click on the crosspoints to execute 
switches.

Epica DGX 144 LED Indicators

Indicator Normal Display Cautionary Display

Front Panel

POWER
(power status) Green

RPS (redundant 
power supplies) Green

Blinking green:  no redundancy
Blinking Red:  80 to 100% power load
Red:  system will not enable DC power
for switching

COMM (Ethernet 
link communication 
status)

Blinking green indicates 
activity

Power Supply

AC Power ( ) Green Not illuminated:  AC failure

DC Power ( ) Green Not illuminated:  DC failure

Temperature ( ) Not illuminated Amber:  power supply is over temperature

CPU

COMM (Ethernet 
link communication 
status)

Blinking green indicates 
activity when linked via 
Ethernet connector

STATUS Blinking green
Blinking red/green: an exception has been 
logged in IOS (validation failure)
Blinking red: dropped into IOS mode*
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Power 
screen
APWeb
For startup information, see the APWeb Server Module’s documentation.

HyperTerminal
When power is applied to the enclosure, HyperTerminal displays a one-line splash screen followed by 
“Ready” (FIG. 21). The system is ready to disconnect the factory default switch and to execute a test 
switch (see page 41). If you need to access advanced system information* through HyperTerminal, see 
“Appendix D – Programmer’s Interface for System Diagnostics” on page 93.

Note: AMX reserves the right to add to the contents of the splash screen at any time, without notice.

* Advanced system information is also available through APDiagnostics software (see page 79).

Redundant Power Supply (RPS)
Each enclosure ships with up to four mutually-redundant (hot-swappable) power supplies.

Depending on how many power supplies are in the system and the load of the system, the RPS indicator 
on the front of the enclosure may blink (red or green) if a problem occurs. Check the AC and DC LED 
indicators on the rear of the enclosure directly above each power receptacle to determine if a power 
supply is not working.

For additional LED indicator information, see page 39.

Important: A failed power supply should be replaced as soon as possible to maintain the system’s 
power redundancy. For replacement information, contact technical support (see page 43). 

Troubleshooting
If a power supply’s AC and DC power indicator LEDs are not illuminated:

T Check to be sure the power cord is completely plugged in.

If the AC and DC LEDs remain unilluminated, contact technical support (see page 43).

Caution: Do not remove a failed power supply until you have the replacement and are ready to 
install it, unless directed to do so by technical support. The Epica DGX 144 enclosure is able to 
operate normally with a failed RPS; however, a failed RPS may prevent the Epica DGX 144 from 
re-booting properly if the system is powered down.

FIG. 21  Power-up splash screen in HyperTerminal

(1:Enclosure) AutoPatch EpicaDG

Ready

up splash 
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Executing a Test Switch
For new system installations, we recommend executing a test switch to verify the system is working 
properly before attaching all inputs and outputs. Aside from having signal cables and a controller 
attached, the system is ready to execute switches when it ships from the factory.

You can execute a test switch from the following:

z AMX control device

z AMX AutoPatch control software, such as APControl 3.0 or APWeb

z BCS (Basic Control Structure) commands over an external controller 

z An external third-party controller

Executing a Test Switch

Before executing the test switch, make sure the first two source devices and the first two destination 
devices are connected to the first two input and output connectors. Any applicable DGX SC Fiber 
modules will also need to be installed (see the module’s documentation). For specific board connector 
information and specifications, see the specific board chapter in this manual.

After the devices are connected, power must be applied to the enclosure and then to the devices before 
executing a test switch.

When executing a test switch, we suggest routing Input (source) 1 to Output (destination) 2 on the 
factory default virtual matrix, VM 0 (for additional information on VMs, see page 69).

After the test switch has executed successfully, you may need to adjust the image with the software 
that is provided on the AMX AutoPatch CD (also available at www.amx.com).

z EDID Programmer software can be used for re-programming the DVI and HD-15 RGBHV 
input boards if necessary (see “Appendix A – EDID Programmer” on page 63). 

z Board configuration software can be used to adjust the source signal for optimal display. 
For information on the DG_HD15 Wizard, see page 54. For information on other types of 
board configuration wizards, see the DGX SC Fiber module’s documentation.

AMX Control Device
For executing and disconnecting switches, see the instruction manual for the specific interface.

APControl 3.0 or APWeb
Directions for executing and disconnecting switches using APControl 3.0 are found in its Help file. 
For directions for executing switches using APWeb, see the Instruction Manual – APWeb.

BCS Commands
To enter BCS commands, the system must be attached to a serial control device (see page 30, “Attaching 
External Controllers”) running a terminal emulation program (such as HyperTerminal). The settings on 
the PC serial communication software and the enclosure must correspond to each other. For setting 
information, see page 32.

When using HyperTerminal, command characters are entered and sent to the enclosure’s CPU (the 
command characters appear in HyperTerminal when the enclosure responds). When all of the entered 
characters appear in HyperTerminal, the command has been successfully executed.

The following test switch routes Input 1 to Output 2 on Level 0 (VM 0).
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To execute the test switch:

1. Enter the following BCS command line:
CL0I1O2T

When the “T” appears, the system has successfully executed the command. If any other character(s) 
appears, the command was not successful. Verify that the source signal is present (visible and/or audible) 
at the destination.

For a complete list of BCS commands and responses, see the Instruction Manual – BCS Basic Control 
Structure Protocol on the AMX AutoPatch CD or at www.amx.com.

Troubleshooting

If the test switch did not execute correctly:

T  Check the power indicator on the front of the enclosure. 
If the indicator is not illuminated, check the power cords at the enclosure and at the power 
source.

T  Check all power switches on the source and destination devices to make sure they are all 
turned on.

T  Verify the status of the test switch. If the status returns as routed correctly, the system 
established a connection between the specified input and output connectors within the 
enclosure.
If using BCS commands, enter “SL0O2T”. If “SL0O2T(1)” appears, the test switch is 
routed.

T  Check all link and signal connections on the rear of the enclosure(s) to make sure everything is 
physically set up correctly.

T If applicable, check connections on the DGX SC Fiber modules (also see “Troubleshooting” in 
the module’s instruction manual).

T Depending on the board type:

z Isolate source/destination equipment and cable problems by patching around the router 
using a cable adapter (FIG. 22) to check the overall signal path.

z Check the SC fiber connectors to make sure they are fully inserted into the DGX SC 
Fiber module and that no dust or debris is on the exposed fiber ends of the cable or on the 
module.

z Check the documentation for the DGX SC Fiber modules to be sure they are installed 
correctly. Isolate source and destination devices using the modules to bypass the 
enclosure to check the fiber cable and overall signal path.

T  Attempt the switch again.
If the switch still does not work, contact technical support (see page 43).

FIG. 22  DVI and SC fiber cable adapters
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Technical Support
Before contacting technical support with a question, please consult this manual. If you still have 
questions, contact your AMX representative or technical support. Have your system’s serial number 
(normally located on the rear of the enclosure) ready.

We recommend recording your system’s serial number in an easily accessible location.

AMX Contact Information
z 3000 Research Drive, Richardson, TX 75082

z 800.222.0193

z 469.624.8000

z Fax 469.624.7153

z Technical Support 800.932.6993

z www.amx.com
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Epica DGX 144 SC Fiber Boards
Epica DGX 144 SC Fiber Boards

Applicability Notice

This chapter pertains to the following Epica DGX 144 SC Fiber boards:

z FG1055-440     Input board 

z FG1055-450     Output board

Epica DGX 144 enclosures can hold up to eighteen DGX SC Fiber boards with 16 inputs or outputs per 
board. Each board has 16 SC fiber connectors.

Each enclosure holds a maximum of nine input and nine output boards, accommodating connector 
configurations up to a maximum of 144x144, as well as subsets (e.g., 128x64 and 80x112).

DGX SC Fiber input boards route signals to any type of Epica DGX 144 output board. DGX SC Fiber 
output boards accept signals from any type of Epica DGX 144 input board. When routing signals 
between different board types, the Epica DGX 144 automatically converts the signal format to match the 
output board. For other types of available boards, see the “Applicability Notice” on page 7.

Important: DGX SC Fiber boards must be used in conjunction with DGX SC Fiber modules (see the 
compatibility list on page 46 and the system setup information on page 47).

FIG. 23  Epica DGX 144 SC Fiber boards
45Epica DGX 144 Instruction Manual



Epica DGX 144 SC Fiber Boards
Specifications Epica DGX 144 SC Fiber
Applies to DGX SC Fiber input board FG1055-440 and DGX SC Fiber output board FG1055-450.

Compatible AMX AutoPatch DGX SC Fiber modules: 

z FG1010-200-01 – AVB-TX-DGX-HD15-SC Fiber

z FG1010-210-01 – AVB-TX-DGX-DVI-SC Fiber 

z FG1010-400-01 – AVB-RX-DGX-SC Fiber-RGBHV

z FG1010-410-01 – AVB-RX-DGX-SC Fiber-DVI

Note: Either TX module can be used in conjunction with either RX module.

* 96 kHz audio is only available when the source video resolution is 800x600 @ 60 Hz (40 MHz pixel clock) or 
greater. Otherwise, the maximum is 48 kHz.

**3,000 ft. cable requires 50/125 μm OM2 class low loss fiber cable. Transmission distance will vary (more or 
less) depending on the type/quality of fiber used, fiber bandwidth, cable bend radius/kinks, splicing quality and 
quantity, and chromatic or modal dispersion.

***480i and 576i are only available when being transmitted from a DGX HD-15 TX as a Y-Pb-Pr signal. 

Important: These boards are compatible only with other AMX AutoPatch products that support 
the DGX single fiber technology. They are not compatible with third-party optical distribution 
amplifiers or multimode to single-mode converters.

AMX reserves the right to modify its products and their specifications without notice.

Epica DGX 144 SC Fiber Specifications

Parameter Value

Compatible AutoPatch Fiber Products DGX HD-15 TX and RX, DGX DVI TX and RX, other AMX AutoPatch 
DGX SC Fiber signal management products     

Safety Certifications
(DGX SC Fiber output board only)

Class 1 Laser Product (Class 3R Laser Product when fiber is 
disconnected from the unit) IEC 60825-1, 2001 

Signal Types over Fiber Video, audio, serial data
Video signal must be present to pass audio and serial data

Resolution Support 640x480 @ 60 Hz up to 1920x1200 @ 60 Hz

Audio Support Analog stereo or S/PDIF (S/PDIF up to 96 kHz sample rate*)

Serial Data Support Unidirectional RS-232, up to 115.2 k baud

Fiber Cable Types Multimode Simplex (with SC termination)
50/125 μm (preferred) or 62.5/125 μm

Fiber Cable Length Up to 3000 ft. (914.4 m) in with 50 μm cable** 
Up to 3000 ft. (914.4 m) out with 50 μm cable**
Up to 1500 ft. (457.2 m) in with 62.5 μm cable
Up to 1500 ft. (457.2 m) out with 62.5 μm cable

Interlaced Resolution Support 1080i 60, 59.94, 50 (fields per second)
576i 100, 50 (fields per second)*** 
480i 60 (fields per second)*** 

Optical Budget 9.75 dBm (typical) between DGX TX and DGX SC Fiber input board
9.75 dBm (typical) between DGX SC Fiber output board and DGX RX
Optical Modulation Amplitude (OMA): -6.25 dBm (typical) 
Optical Modulation Amplitude (OMA) Sensitivity: -16.0 dBm (typical)

Power (max. output of laser radiation) 
(DGX SC Fiber output board only)

4.08 mW

Fiber Connector (on board) SC Optical
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System Setup with DGX Modules
DGX SC Fiber input and output boards are used in conjunction with AMX AutoPatch DGX SC Fiber 
TX and RX modules. Compatible DGX SC Fiber modules are listed on page 46. For module installation 
details and specifications, see the module’s Quick Start Guide or Installation Manual.

When the modules are installed, image adjustment and EDID scaling is automatically applied. For 
almost every installation, the automatic features on the modules result in a satisfactory image on the 
monitor. If the installation has special requirements and needs additional adjustment or if you need 
product specifications for the modules, refer to the Instruction Manual – DGX Transmitters & Receivers  
on the AMX AutoPatch CD or at www.amx.com.

The distance from a DGX SC Fiber TX module to a DGX SC Fiber input board can be up to 3,000 feet 
(914.4 m) and another 3,000 feet from a SC Fiber output board to a DGX SC Fiber RX module.

Note: Along with the video signal, the DGX SC Fiber boards support embedded digital audio and 
embedded analog stereo audio from the DGX SC Fiber modules. They also support the 
transmission of unidirectional RS-232 (EIA-232) serial data with the data flow in the same direction 
as the video signal.
Important: The RS-232 connection on the modules requires management of the RS-232 data line in 
relation to switching operations. In an upstream matrix switching scenario, we recommend that 
RS-232 control commands (via the DGX RS-232 data connection) are not sent immediately prior or 
subsequent to a matrix switching command. It is possible for the RS-232 data to be corrupted as the 
video (or audio) signal is removed and then restored by the matrix switcher.

The system setup in FIG. 24 illustrates DGX SC Fiber boards used in conjunction with DGX modules. 
The Transmitter modules (HD-15 and DVI) can be installed interchangeably. The Receiver modules 
(HD-15 and DVI) are interchangeable as well, providing for an extremely flexible system. For example, 
in the same system the source device can send a DVI signal and the destination device can receive an 
RGBHV signal.

Tip: For systems with special requirements – Before installing in the final location, place the 
equipment close together, so the Control PC and the destination monitor can be seen 
simultaneously if adjustments are necessary.

FIG. 24  DGX SC Fiber boards used in conjunction with DGX SC Fiber modules

Destination Device

SC fiber up to 3000 ft. (914 m)

Source Device

USB

DGX TX
DGX RX

Control PC for setup – 
only necessary for systems 
with special requirements

SC fiber up to 3000 ft. (914 m)

Epica DGX 144 with 
DGX SC Fiber boards
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Safety Recommendations for Laser Products
Important: No user serviceable parts are inside an AMX AutoPatch product; service should only be 
done by qualified personnel.
Caution: Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure. 

Exercise caution when installing DGX products to avoid direct eye exposure to invisible laser radiation.  
Follow the recommendations below whenever installing or working with DGX products.

T  Be sure to apply the power only after all fiber connections are made and no fiber ends are 
exposed. 

T  Do not remove dust plugs from SC fiber connectors or the dust caps from the fiber cables until 
establishing connections; avoid direct eye exposure.

T  Make sure all cables, including fiber cables, are correctly connected and/or terminated. 

T  Before you unplug a fiber cable on an input board, disconnect the power on the DGX TX that 
is connected to the input.

T  Before you unplug a fiber cable on an output board, disconnect the switch for that output 
connector.

Attaching Cables
Instructions for attaching cable management bars are on page 23. These bars are recommended and 
provided with each fiber board.

Caution: Do not severely bend or kink the SC fiber cable. Irreversible damage can occur. Refer to 
the physical limitations (bend radius) specified for the cable. The bend radius for AMX SC 
terminated fiber cables is 2 inches (5 cm).

Check When Fastening Fiber Cables: 

z Make sure that no dust or debris is on the exposed ends of the fiber cable.

z Make sure that the fiber cable connectors seat firmly into the board and module connectors. 
Normally an audible click is heard when a connector engages.

 

To connect SC fiber inputs and outputs: 

1. Recommended – Install the provided cable management bars (see page 23).

CAUTION: CLASS 3R INVISIBLE LASER RADIATION WHEN OPEN; AVOID DIRECT EYE 
EXPOSURE.

2. Clean the fiber cable connector – Follow the manufacturer’s recommendations.

3. Remove the protective cap from the SC fiber connector.
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4. Insert the fiber cable connector into the input and output SC fiber receptacles (FIG. 25).

5. Tie the SC fiber cable to the cable management bar far enough below the connector to allow for the 
manufacturer’s recommended bend radius. The bend radius for AMX SC terminated fiber cables is 
2 inches (5 cm).

6. Repeat the previous steps for the remaining fiber cables.

Important: The RS-232 connection on the modules requires management of the RS-232 data line in 
relation to switching operations. In an upstream matrix switching scenario, we recommend that 
RS-232 control commands (via the DGX RS-232 data connection) are not sent immediately prior or 
subsequent to a matrix switching command. It is possible for the RS-232 data to be corrupted as the 
video (or audio) signal is removed and then restored by the matrix switcher.

FIG. 25  Fasten cables onto input and output connectors (shown with cable management bar)

Tie cable to cable management bar
far enough below connector to allow 
for manufacturer’s recommended
bend radius
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Epica DGX 144 HD-15 RGBHV Input Board
Epica DGX 144 HD-15 RGBHV Input Board

Applicability Notice

This chapter pertains to the following Epica DGX 144 HD-15 RGBHV input board:

z FG1055-480     Input board

Epica DGX 144 enclosures can hold up to nine DGX 144 HD-15 RGBHV input boards with sixteen HD-
15 connectors each. Each enclosure holds a maximum of nine input and nine output boards (for available 
output boards, see the “Applicability Notice” on page 7), accommodating connector configurations up to 
a maximum of 144x144, as well as subsets (e.g., 128x64 and 80x112).

DGX HD-15 RGBHV input boards route signals to any type of Epica DGX 144 output board. When 
routing signals between different board types, the Epica DGX 144 automatically converts the signal 
format (analog to digital or digital to analog) to match the output board. (When DGX HD-15 RGBHV 
Input Boards are used with DGX SC Optical Output Boards, the signals are converted to fiber and then 
converted by a DGX RX; see “System Setup with DGX Modules” on page 47). For other types of 
available boards, see the “Applicability Notice” on page 7. 

Available Software

Board configuration software is provided to adjust the source signal for optimal display (see page 55). 
EDID Programmer software is also included for re-programming the input boards if necessary 
(see “Appendix A – EDID Programmer” on page 63). Both programs are available on the AMX 
AutoPatch CD and at www.amx.com.

FIG. 26  Epica DGX 144 HD-15 RGBHV input boards
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Specifications Epica DGX 144 HD-15 RGBHV
Applies to DGX HD-15 RGBHV input board FG1055-480.

EDID Resolutions Supported through Local DDC

Standard Timings

* This is the preferred timing identified in the EDID.

Established Timings

AMX reserves the right to modify its products and their specifications without notice.

Epica DGX 144 HD-15 RGBHV Specifications

Parameter Value

Signal Type RGBHV Input

Resolution Support 640x480 @ 60 Hz up to 1920x1200 @ 60 Hz

Pixel Clock (max.) 165 MHz

DDC/EDID Support EDID provided by Epica DGX 144
EDID is user re-programmable

RGB In Signal Level Range 0 to 700 mVpp (0 to 750 mVpp max.)

RGB Input Impedance 75 ohms

HV Sync Input Signal Range 0 to +5 V

HV Sync Input Impedance 510 ohms

HV Sync Input Trigger Voltage +1.25 V

Input Connector HD-15

Standard Timing
 Identification

Resolutions Refresh Rate Max.

ID 1 1920x1200* 60 Hz

ID 2 1920x1080 60 Hz

ID 3 1680x1050 60 Hz

ID 4 1600x1200 60 Hz

ID 5 1280x800 60 Hz

ID 6 1280x720 60 Hz

ID 7 1280x1024 60 Hz

ID 8 640x480 120 Hz

Resolutions Refresh Rate Max.

720x400 70 Hz, 88 Hz

640x480 60 Hz, 67 Hz, 72 Hz, 75 Hz

800x600 56 Hz, 60 Hz, 72 Hz, 75 Hz

832x624 75 Hz

1024x768 60 Hz, 70 Hz, 75 Hz, 87 Hz

1280x1024 75 Hz

1152x870 75 Hz
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Attaching Cables

To connect HD-15 inputs:

1. Fasten the cables onto the HD-15 input connectors (FIG. 27).

HD-15 Pinout

Pinout information for the High Density HD-15 connectors on the DGX HD-15 RGBHV input board is 
provided in the table next to FIG. 28.

FIG. 27  Fasten cables onto input connectors

FIG. 28  HD-15 RGBHV input board connector pinout

Input (VESA DDC Compliant)

1. Red 6. Red GND 11. ID Bit

2. Green 7. Green GND 12. DDC SDA

3. Blue 8. Blue GND 13. Horizontal Sync

4. ID Bit 9. +5 V in DDC 14. Vertical Sync

5. GND 10. GND 15. DDC SCL
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Board Configuration
The source signal routed through a DGX HD-15 RGBHV input board may need to be adjusted to obtain 
optimal display at the destination. Board configuration software, the DG_HD15 Wizard, is provided on 
the AMX AutoPatch CD for this purpose.

System Requirements

z Control PC 

z Windows® 2000 or Windows® XP Professional

z 2 MB free disk space

z 15 MB RAM

z Serial port

Control PC

The Control PC runs the DG_HD15 Wizard software, which adjusts the video source signal as its image 
is viewed on the destination monitor. The Control PC is connected with a null modem cable to the serial 
port on the Epica DGX 144. Once the boards have been configured, the Control PC can be disconnected, 
unless further changes to the display settings are necessary.

Source PC (or other RGBHV video source)

The Source PC is connected to the DGX HD-15 RGBHV input board. The Source PC must have a video 
card that supplies analog RGBHV at one of the resolution and refresh rates in the table below. If you 
need to determine the resolution and refresh rate for the Source PC, see page 55.

Destination Monitor

The Destination Monitor can be connected to any of the Epica DGX 144 output boards. Adjustments 
made with the Wizard are seen on the Destination Monitor.

Test Image Files

Three types of test image files (resolution, color bars, and phase test) for adjusting the display are 
provided on the AMX AutoPatch CD. They are located at: <installation folder>\Test Patterns. Test image 
files* are opened on the Source PC and subsequently display on the Destination Monitor.

* Adobe Acrobat Reader is required to view the test image .pdf files. Acrobat Reader is a free program 
available online at www.adobe.com.

Resolution Refresh Rate

640x480 60 to 85 Hertz

800x600 60 to 85 Hertz

1024x768 60 to 85 Hertz

1152x864 60 to 85 Hertz

1280x720 60 to 85 Hertz

1280x768 60 to 85 Hertz

1280x1024 60 to 75 Hertz

1600x1200 60 Hertz

1680x1050 60 Hertz

1920x1080 60 Hertz

1920x1200 60 Hertz
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Determining Resolution and Refresh Rate for Source PC

If you do not know the video card resolution and refresh rate on the Source PC, use the directions below 
to find out before attempting to adjust the video display. Because video display settings cannot be 
recalled, we strongly recommend writing this information down.

To determine video card resolution/refresh settings on Windows® operating systems:

1. Minimize all applications on the Source PC.

2. Right click on the desktop.

3. Select Properties from the shortcut menu.

4. Select the Settings tab in the Display Properties dialog box.

5. Check the Screen resolution setting; write it down.

6. Click Advanced.

7. Select the Monitor tab.

8. Check the Screen refresh rate (frequency, which is expressed in Hertz); write it down. 
If this setting is not located under the Monitor tab, try selecting other available tabs.

9. Click Cancel on each dialog box to exit.

Important: If all of the device EDIDs do not fall within the default resolution parameters provided 
(check “Specifications” on page 52), see “Appendix A – EDID Programmer” on page 63 before 
adjusting the video with the DG_HD15 Wizard.

Adjusting the Video with the DG_HD15 Wizard

Before starting the adjustment procedure:

z Install the DG_HD15 Wizard on the Control PC. (We recommend uninstalling any versions 
of BoardConfig software prior to v1.4.0 first.)

z Connect the Control PC via a null modem cable to the serial port on the Epica DGX 144.

z Transfer the test image files from the Control PC to the Source PC.

z Determine the resolution and refresh rate of the Source PC (see instructions above).

Adjustment Tips:

z Be sure that the source device that is sending the signal to the display monitor (or device) 
has a sharp picture before you start.

z The Destination Monitor controls may need adjusting during the following procedure.

z For some 640x480 displays, selecting an 800x600 resolution from the wizard may work best.

To adjust the video display using the DG_HD15 Wizard:

1. Route the signal from the Source PC to the Destination Monitor.
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2. On the wizard, select the source in the navigation tree in the upper left corner that corresponds to the 
input connector number for the source signal to be adjusted.

3. Use the File\Open menu and select the supplied (preset) resolution file (<installation folder>\ 
presets\defaults\DG_HD15) that matches or closely matches the Source PC’s settings. 
(The .xml file name consists of the resolution followed by the refresh rate. If not indicated, the 
refresh rate is the default of 60 Hz.)

4. Select the Horizontal Resolution icon. Verify that the value above the scroll bar matches the 
horizontal value of the resolution file. If necessary, move the scroll bar as close to the correct value 
as possible and then click a scroll arrow until the value is exact. For example, for 1280x960 move 
the scroll bar as close to 1280 as possible; then click a scroll arrow until the value is exactly 1280. 

5. Select the Vertical Resolution icon and repeat the previous step for the vertical value of the 
resolution file.

Important: After a preset has been loaded and the resolution values have been verified, further 
adjustments may not be required. If this is the case, go to Step 13 to complete the procedure.

6. On the Source PC, open the test image PDF that matches the resolution setting.
If an image does not appear, change the Source PC’s video card settings to match one of the 
supported resolution files (see “Specifications” on page 52).

7. Select the Horizontal Total Pixels icon. Adjust one step at a time (click on either scroll arrow), 
watching the vertical noise lines (bands) on the Destination Monitor mover farther apart. Stop when 
the bands disappear.

8. On the Source PC, open the Colorbars.pdf file. In Acrobat Reader under the View menu, select 
Actual Size.

9. Select the Red Gain icon. Watch the color section of the image as you adjust the red gain.

10. Repeat Step 9 for the Green Gain icon and for the Blue Gain icon (you may need to go back and 
forth a few times among the colors to reach the optimal result).

FIG. 29  Select source in navigation tree

Select source to adjust
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11. Adjust the rest of the icons if needed, keeping the following tips in mind:

z Horizontal Position 

z If not working, try adjusting Horizontal Pulse Width first and then retry Horizontal 
Position.

z CRT screens may need to use the screen controls to fine tune for size and position.

z Vertical Position 

z CRT screens will often go blank for a moment on each adjustment. 
z To quickly make large adjustments to CRT screens, use the Page Up / Page Down keys.

z Horizontal Pulse Width

z The default normally works well for higher resolutions.
z For lower resolutions that do not fit the display well, try increasing the value.
z Reduced blanking resolutions (>1600x1200) require a small value.

z Phase Timing

z If you try to adjust this setting and do not see a difference, adjustment is not necessary.
z If adjustment is needed, open the file PhaseTest.pdf. 

Watch the image and adjust to even out any picture variation.

12. Repeat as many of the steps above as necessary for additional sources (see Time Saving Tip below).

13. From the Options menu, select Save to System (to restore settings upon power up). 
The Save to System Dialog box opens.

14. Click OK.

15. From the File menu, select Save As to save a backup file to the PC.

16. Enter a file name, and click Save.

17. Disconnect the Control PC when finished.

Time Saving Tip: If additional source devices of the same type are connected to the same type of 
destination devices, the setting for the file saved in Step 14 can be applied to those sources. Use the 
following directions.

To apply settings to multiple sources:

1. From the Options Menu, select Enable Multiple Selections.

2. Select (highlight) the label for the source whose settings need to be duplicated.

3. Click the check boxes for all sources that require the same settings as the selected source.

4. From the Options Menu, select the submenu Copy to Selected \ Current Profile.
The settings from the highlighted source are applied to all sources that were selected in Step 3.

FIG. 30  Select source to copy settings from; check source(s) to apply settings to
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5. From the Options menu, select Save to System (to restore settings upon power up). 
The Save to System Dialog box opens.

6. Click OK.

7. From the File menu, select Save As to save a backup file to the PC.

8. Enter a file name, and click Save.

9. Disconnect the Control PC when finished.
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Epica DGX 144 DVI Boards

Applicability Notice

This chapter pertains to the following Epica DGX 144 DVI (Digital Visual Interface) boards:

z FG1055-460     Input board

z FG1055-470     Output board

Epica DGX 144 enclosures can hold up to eighteen DGX DVI boards (nine input and nine output) with 
eight DVI-I plus four DMS-59 connectors each. The DMS-59 connectors break out to allow two DVI 
connections each for a total of 16 input or output channels per board.  

DGX DVI input boards can route signals to any type of Epica DGX 144 output board. DGX DVI output 
boards can accept signals from any type of input board. When routing from one board type to another, 
the Epica DGX 144 automatically converts the signal format to match the output board. (When DGX 
DVI Input Boards are used with DGX SC Optical Output Boards, the signals are converted to fiber and 
then converted by a DGX RX; see “System Setup with DGX Modules” on page 47). For other types of 
available boards, see the “Applicability Notice” on page 7.

DGX DVI boards only support digital, single link (DVI-D) signals. The DVI connectors on the boards 
are DVI-I, which allow use of cables with either DVI-D or DVI-I connectors (for DVI-I, the analog pins 
are not used; see the DVI-I connector pinout information on page 62).

The DGX DVI input boards also have local DDC (Display Data Channel) support with plug-and-play 
information provided by the Epica DGX 144 Distribution Matrix. 

Note: The DGX DVI input board does not support HDCP required compliant signals.

EDID Programmer software is included on the AMX AutoPatch CD (also available at www.amx.com) 
for re-programming the input boards if necessary (see “Appendix A – EDID Programmer” on page 63).

FIG. 31  Epica DGX 144 DVI boards
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Specifications Epica DGX 144 DVI
Applies to DGX DVI input board FG1055-460 and DGX DVI output board FG1055-470.

EDID Resolutions Supported through Local DDC

Standard Timings

* This is the preferred timing identified in the EDID.

Established Timings

AMX reserves the right to modify its products and their specifications without notice.

Digital Video – DVI Specifications

Parameter Value
Signal Type DVI-D (single link)

Resolution Support 640x480 @ 60 Hz up to 1920x1200 @ 60 Hz

Interlaced Resolution Support 1080i 60, 59.94, 50 (fields per second)
576i 100, 50 (fields per second)
480i 60 (fields per second)

Data Rate (max.) 4.95 Gbps

Pixel Clock (max.) 165 MHz

DDC/EDID Support EDID provided by Epica DGX 144
EDID is user re-programmable

HDCP Support No

Input Voltage (nominal) 1.0 Vpp differential

Input Cable Equalization Up to 50 ft. (15.24 m)

Output Voltage (nominal) 1.0 Vpp differential

Output Reclocking Yes

Output + 5 V DDC Pin 50 mA

Output Rise Time / Fall Time 80 ps min. to 200 ps max. (20% to 80%)
0.13 UI min. to 0.33 UI max. (@ 1.65 Gbps, 20% to 80%)

DVI Input Board Propagation Delay 2 μs

DVI Output Boards Propagation Delay 3 μs

Input and Output Connectors DVI-I (single link DVI-D is the supported signal type)

Standard Timing
 Identification

Resolutions Refresh Rate Max.

ID 1 1920x1200* 60 Hz
ID 2 1920x1080 60 Hz
ID 3 1680x1050 60 Hz
ID 4 1600x1200 60 Hz
ID 5 1280x800 60 Hz
ID 6 1280x720 60 Hz
ID 7 1280x1024 60 Hz
ID 8 640x480 120 Hz

Resolutions Refresh Rate Max.

720x400 70 Hz, 88 Hz
640x480 60 Hz, 67 Hz, 72 Hz, 75 Hz
800x600 56 Hz, 60 Hz, 72 Hz, 75 Hz

1024x768 60 Hz, 70 Hz, 75 Hz, 87 Hz
1280x1024 75 Hz
1152x870 75 Hz
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Attaching Cables

To connect DVI inputs and outputs: 

1. Fasten the DVI-I (or DVI-D) connectors on the cable ends onto the DVI-I input or output 
connectors on the boards. For DVI pinout information, see page 62.

To connect DMS-59 inputs and outputs:

1. Fasten the breakout cables onto the DMS-59 input or output connectors on the board (FIG. 32).

2. Fasten the DVI cable connectors to the breakout cables (be sure to read “Connector Numbering 
Correspondence for Breakout Cable” below).

Connector Numbering Correspondence for Breakout Cable

The two DVI connectors on the DMS-59 breakout cable are labeled 1 (bottom connector) and 2 (top 
connector). They route signals according to the numbering to the left of the DMS-59* receptacle: 
1 corresponds to the receptacle number with the lower numerical value and 2 corresponds to the number 
with the higher numerical value. For example, on the DMS-59 breakout cable for Inputs 11 and 12 
(FIG. 32), the DVI connector labeled 1 routes the signal for Input 11 and the DVI connector labeled 2 
routes the signal for Input 12.

* The configuration file and the internal pathways define each DMS-59 connection as two discrete signal 
paths for routing.

FIG. 32  Fasten cables onto input and output connectors

DMS-59 connector 

DVI-I connector

Read “Connector Numbering Correspondence
for Breakout Cable” below

(two input or output 
channels each)
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DVI Pinout

Pinout information for the DVI-I connector on DGX DVI input and output boards is provided in the 
chart below FIG. 33.

* On the input connectors, pin 14 is a +5 V sink. On the output connectors, pin 14 is a +5 V source with a 
maximum current limitation of 55 mA

FIG. 33  DVI-I connector pinout

DVI-I Pinout Information

1. Data 2-  9.  Data 1- 17. Data 0- C1. No connect

2. Data 2+ 10. Data 1+ 18. Data 0+ C2. No connect

3. Ground 11. Ground 19. Ground C3. No connect

4. No connect 12. No connect 20. No connect C4. No connect

5. No connect 13. No connect 21. No connect C5. No connect

6. DDC-CLK 14. +5 V* 22. Ground

7. DDC-Data 15. Ground 23. CLK+

8. No connect 16. Hot-Detect 24. CLK-
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Appendix A – EDID Programmer

EDID Programmer software is provided for re-programming the EDID EEPROM chips on the 
Epica DGX 144 DVI and HD-15 RGBHV input boards if necessary. This software is available (along 
with board configuration software) on the AMX AutoPatch CD or at www.amx.com.

Note: Board configuration software is used to adjust the source signal for optimal display at 
the destination. For information on the DG_HD15 Wizard, see the “Epica DGX 144 HD-15 RGBHV 
Input Board” chapter on page 54. For information on other types of board configuration wizards, see 
the specific accessory module’s documentation.

EDID Overview
EDID (Extended Display Identification Data) is a data structure established by the Video Electronics 
Standards Association (VESA) to enable plug-and-play support by enabling easy configuration of 
a computer’s graphics subsystem based on the capabilities of the attached display device.

EDID information includes items such as the following:
z Manufacturer’s name 
z Product type 
z Supported video resolutions and refresh rates
z Color space and filter chromaticity 
z Detailed timings

When a computer is directly connected to a display device, it can use the display device’s EDID 
information to determine an initial compatible video signal to send. With the computer’s display 
controls, the user can modify this selection to another compatible signal based on the provided EDID 
information.

With DVI (which requires EDID on the display devices), using EDID information has extended beyond 
computers to other source devices, such as DVD players. As long as the source device sends a 
compatible signal, the plug-and-play feature will work.

Matrix Switchers and EDID

Matrix switchers, such as the Epica DGX 144, provide the ability to route one source signal to many 
potentially different types of display devices. Through the use of compatible DGX SC Fiber Receivers 
featuring SmartScale™, in almost all cases, incompatibilities between source device resolutions and 
displays are automatically resolved as each receiver independently scales each source device’s video to 
the display’s native resolution. 

In cases where local DVI outputs are used and a resolution incompatibility exists (or if a source device 
desires a specific resolution), the DGX DVI input board and the DGX HD-15 RGBHV input board are 
provided with the ability to update the EDID emulation file (by updating each input’s EEPROM chip) 
which comes pre-loaded with an AMX AutoPatch EDID set.

This EDID set consists of some of the most common EDID settings in use today, including all VESA 
Established Timings encompassing 8 resolutions at a variety of refresh rates and 8 additional Standard 
Timings encompassing 8 resolutions and refresh rate combinations (for DVI timing details, see page 60; 
for RGBHV, see page 52). In many cases, the matrix switcher can be used straight out of the box with no 
adjustments (see “Determining the Need for EDID Programming” on page 64).

The EDID Programmer software has been provided for cases where additional in-field programming of 
the EDID chips is needed. The EDID Programmer can be used for the following:

z Reading and saving EDID data from a device

z Writing EDID data to an AMX AutoPatch matrix switcher’s input connector’s associated 
EDID EEPROM
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Note: Any analysis or editing of the EDID data necessary to support the equipment specific to your 
installation will need to be done separately prior to using the EDID Programmer. A variety of 
freeware tools can be found on the web to help with these tasks.

Keep in mind that the EDID information for some equipment may not be compatible with the remaining 
equipment even with programming. In those cases, the signals will have limited routing options.

Tip: If the signal from some of the equipment can only be routed to part of the destinations due to 
incompatible EDIDs, control can be simplified by creating a separate virtual matrix (level) for the 
inputs and outputs involved. To request a modified configuration file with new virtual matrices, 
contact technical support (see page 43) or see the XNConnect Help file for directions.

The remaining sections provide information on:

z Determining the need for EDID programming

z Installing the EDID Programmer

z Reading and saving EDID data from a destination device

z Writing data to an Epica DGX 144 input connector

Determining the Need for EDID Programming
Ideally the EDID analysis will have been completed during installation specification. Consideration 
should be given to the use of  DGX SC Fiber output boards and corresponding DGX SC Fiber Receivers 
which (in almost every case) will remedy incompatible source and destination resolution issues. Specific 
attention should be given to local output boards which do not provide automatic scaling via the 
SmartScale™ functionality. If this was not possible but all of the system’s devices are now available, 
the most effective way to proceed is to test if the signal from each of the source devices can be routed 
through the Epica DGX 144 to each of the destination devices. If they can be routed, then EDID 
programming is not necessary. 

A method of control is not specified in the following instructions. 

To determine if EDID programming is necessary:

1. Route the first input to all of the applicable outputs.

2. Check each destination display to verify that the picture is present, making note of any that are not.

3. Repeat Steps 1 and 2 for each of the remaining inputs.

Important: If any of the destinations do not display a picture, analysis or editing of the EDID data 
may be necessary prior to using the EDID Programmer. A variety of freeware tools can be found on 
the web to help with these tasks.
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Installing the EDID Programmer
PC System Requirements (v1.2.0)

T Windows® 2000 or Windows® XP Professional 

T Minimum Hardware: 166 MHz, 128 MB RAM, 20 MB of free disk space*, 800x600 display, 
serial port, video card with dual outputs**

T Recommended Hardware: 2.0 GHz, 512 MB RAM*

* The installation process requires 20 MB of disk space for the EDID Programmer’s installer. Once 
installed, the EDID Programmer requires 5 MB of disk space.
** We strongly urge the user not to use video cards with DMS-59 connectors. Video cards with DMS-59 
connectors have been shown to fail consistently and, in the worst case, can corrupt an EDID data file. A 
laptop PC with a VGA or DVI out is a good solution. Cards with 2 DVI connectors, 2 VGA connectors, 
or 1 DVI and 1 VGA connector are also acceptable. 

To install EDID Programmer software:
1. Locate and open the installer <EDIDProgrammer_1.2.exe> on the AMX AutoPatch CD or at 

www.amx.com.

2. Follow the directions in the wizard.

Reading and Saving EDID Data from a Destination Device
Tip: The Save button in the EDID Programmer can be used to save the EDID information as an 
.edid file, which can be opened as a text file (click on the Open button) and edited or opened and 
written to an input (click the Write button).

The instructions below cover the situation in which the EDID Programmer is used to read the EDID 
information from a destination device in the installation with a DVI connector (an HD-15 connector can 
also be used). Additional information for using cable adapters is provided on the next page.

To read and save EDID data from a destination device:

1. On the PC, open the EDID Programmer.

FIG. 34  EDID Programmer

Available Displays drop down list – select device 

Close – shuts down application; will not prompt to save

 

Open – an EDID file
Save – an EDID file to edit or to write to input on board

Refresh Display List – updates list after additional devices attached

Convert to Digital / Convert to Analog – converts displayed EDID data 

Target Device – select Matrix Switcher

EDID Information – data (read-only) from file or device 

EDID Type – indicates analog or digital (read-only)

Read – reads EDID from selected destination device 
Write – writes EDID to input on board

Communication menu – use to select PC serial port or change baud rate

Status – shows application status (read-only)

Query AutoPatch Device – acquires enclosure’s XNNet ID address
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2. Connect a DVI cable to the PC using the PC’s spare monitor port. If your laptop has an HD-15 
(VGA) port, see “Using Cable Adapters” on the next page.

3. Connect the open end of the DVI video cable to the destination device (typically a monitor) from 
which the EDID information needs to be read.

4. Click the Refresh Display List button to update the Available Displays drop down list.

5. From the Available Displays drop down list, select the destination device from which you need to 
read the EDID.

6. Click the Read button to read the EDID information. The results display in the read-only area.

7. Click the Save button (select location, enter file name, and click Save).
Leave the EDID Programmer open for instructions on writing the EDID data to an Epica DGX 144 
input connector on the next page.

8. Disconnect the DVI cable from the PC and from the destination device.

Using Cable Adapters

If your laptop has an HD-15 (VGA) port, you can use a DVI-to-VGA cable to connect the laptop’s 
HD-15 video port to a DVI cable attached to a destination device’s DVI port. Alternatively, use the 
following combination of adapters with a DVI-D cable to connect the laptop to the destination device: 

Note: The setup of adapters and DVI-D cable in FIG. 35 passes EDID information but not video 
signals.

Writing EDID Data to a DVI or HD-15 RGBHV Input Connector
The instructions that follow cover the situation in which the EDID Programmer is used to write EDID 
information to the EDID chip for an input connector on an Epica DGX DVI input board that still has 
factory default settings. A DGX HD-15 RGBHV input board can be re-programmed using the same 
instructions; use an HD-15 video cable instead of a DVI cable.

To write EDID data to the EDID chip for an input connector:

1. Attach a null modem serial cable without hardware flow control to the serial port (DB-9) on the 
Epica DGX 144. Use a serial cable that matches the pin diagram in FIG. 36 for RS-232. 
AMX AutoPatch equipment uses pins 2, 3, and 5 only.

FIG. 35  Connecting an HD-15 (VGA) port to a DVI port

FIG. 36  RS-232 pinout

PC or 
Laptop

Female VGA (HD-15) adapter 
to Male DVI-I adapter

DVI-I Female to 
DVI-Female adapter

Male DVI-D to 
Male DVI-D cable

Destination 
Device

PC: DB-9
AutoPatch: DB-9
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2. Attach the open end of the serial cable to the PC that the EDID Programmer will be opened on.

3. Use serial communication software to make sure the PC’s baud rate is set correctly for the system. 
The recommended (default) settings for serial communication with an Epica DGX 144 are: 
baud rate – 9600, data bits – 8, parity – none, stop bits – 1, and flow control – none. 

4. Apply power to the enclosure.

5. On the PC, open the EDID Programmer (see page 65).

6. For Target Device, select the Matrix Switcher option.

7. Click the Query AutoPatch Device button to obtain the XNNet ID address from the enclosure.

8. Attach a DVI video cable to the PC using the PC’s spare monitor port.

9. Attach the open end of the DVI video cable to the DVI input connector on the Epica DGX 144 board 
that requires programming.

10. Save the board’s EDID default as a backup (assumes board has factory default EDID programming):

z Click the Refresh Display List button.

z Select the device from the Available Displays drop down list. 

z Click the Read button. 

z Click the Save button (select location, enter file name, and click Save).

11. Click the Open button to select the .edid file to be written to the DVI input connector.

12. Click the Write button to write the EDID information to the DVI input connector.

13. If applicable – Repeat any of the steps that are necessary for any additional DVI input connectors.

14. Disconnect the DVI video cable from the PC and from the Epica DGX 144 input board.

15. Disconnect the serial cable from the PC and from the Epica DGX 144 enclosure.
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Appendix B – Managing Configuration Files

Applicability Notice: This appendix applies to XNConnect version 2.10.0. (XNConnect’s version 
information is found under its Help menu.)

Note: The Epica DGX 144 supports full Device Discovery through AMX’s AutoPatch Duet module.

This appendix covers basic modifications that can be made to a configuration file using XNConnect 
software. For complete coverage of XNConnect, see the Help file.

A configuration file contains system* configuration information which is loaded onto the system at the 
factory. Each enclosure’s CPU references the configuration file, which defines switching behavior. The 
file can be modified using XNConnect configuration software to include custom channel names and 
local presets.

Caution: Use XNConnect only if you need to reload the configuration file or modify your system’s 
configuration from the original specifications. Be sure to copy the current file every time the file is 
modified.

A copy of the configuration file (with an .xcl file extension) is found on the AMX AutoPatch CD shipped 
with each system. If you cannot locate the AMX AutoPatch CD, either download XNConnect from the 
AMX website and see “Discovering a System” on page 72 or contact technical support (see page 43) 
with your system’s serial number for a replacement file. If you are making any modifications other than 
customizing channel names or creating local presets, provide technical support with a copy of the 
modified file for future support.

This appendix covers the following topics: 

z Installing XNConnect (see page 70)
z Opening a configuration file (see page 71)
z Discovering a system (see page 72)
z Navigating the interface (see page 73)
z Customizing channel names/labels (see page 74)
z Creating local presets (see page 75)
z Loading a configuration file (see page 77)
z Device Discovery support (see page 77)

Standard Virtual Matrices and XNConnect
The standard virtual matrix for switching signals in an Epica DGX 144 Distribution Matrix is VM 0, 
which routes video. For video sources that also include audio (e.g., sources with video and embedded 
audio routed through DGX SC Fiber Boards), VM 0 routes the video and any embedded audio. 
Embedded audio does not have a separate VM for switching and cannot be broken away from the video.

VM 1, which switches exactly the same as VM 0, is also provided as an option for compatibility 
purposes with control software and equipment.

Additional VMs can be created and are useful in some situations. Control can be simplified by creating a 
separate virtual matrix for the inputs and outputs involved, e.g., if the signal from some of the equipment 
can only be routed to part of the destinations due to incompatible EDIDs or to provide restricted access 
to certain source or destinations. The XNConnect Help file contains information on creating new VMs.

Caution: Virtual matrix modifications are an advanced feature of XNConnect that should not be 
attempted unless you are extremely familiar with XNConnect and the AMX AutoPatch Distribution 
Matrix being configured.

* A system can be a stand-alone matrix switcher or multiple matrix switchers with or without additional 
controllers and accessories.
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AMX AutoPatch CD Information

If you cannot locate the AMX AutoPatch CD that shipped with your system and your AMX account has 
the required permissions, you can download the newest version of XNConnect from www.amx.com. 
An INI file Updater for updating XNConnect is available on the AMX website under Tech Center \ 
AutoPatch Tools; an account is not required. If you need an .xcl configuration file that is compatible with 
your system, either discover the system (see page 72) or contact technical support (see page 43) and 
provide your system’s serial number.

Installing XNConnect
Use this software only if you need to customize or change the configuration information from the 
original specification.

Note: Even if XNConnect is already on your PC, install the newest version that shipped on the same 
CD as the configuration file. We strongly recommend uninstalling the old version of XNConnect 
before installing a newer version.

System Requirements

T  Windows® XP Professional

T  233 MHz processor

T  Minimum of 128 MB of RAM

T  20 MB of available hard drive space

T  800x600 screen resolution (1024x768 is recommended)

T  Serial port and RS-232 null modem cable

To install XNConnect from the AMX AutoPatch CD:

1. Close all other applications currently running on your PC.

2. Insert the AMX AutoPatch CD into your CD drive to start automatically.
If the CD does not autorun, explore the CD folder and double-click the Index.html file.

3. Select Software and find XNConnect.

4. Optional – Select Release Notes to read about the software before installation.

5. Select Install. 

6. Follow the directions in the subsequent dialog boxes.
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Opening a Configuration File
The process of modifying a configuration file starts by opening it with XNConnect. After the 
modifications are complete, the new configuration information must be loaded onto the system to 
implement the changes.

Note: Even if XNConnect is already on your PC, install the newest version that shipped on the same 
CD as the configuration file. We strongly recommend uninstalling the old version of XNConnect 
before installing a newer version.

If you cannot locate the original factory configuration file, see “Discovering a System” on page 72.

Caution: Use XNConnect only if you need to reload the configuration file or modify your system’s 
configuration from the original specification. Copy the original file every time the file is modified.

To launch XNConnect:

1. From the Start menu, select Programs.

2. Select AutoPatch Applications (or other file group you specified during the installation).

3. Select the XNConnect folder.

4. Select XNConnect.
The XNConnect program opens.

5. From the Getting Started dialog box, click Open Configuration File. 
(If the dialog box does not appear, from the File menu select Open.)

6. Use the standard Open dialog box to locate and open your configuration (.xcl) file. 
The default location is in the MyXCL folder on the AMX AutoPatch CD.

7. Using Save As (under the File menu), make a duplicate copy of the file with a new name and save it 
to the PC. (We strongly recommend making a duplicate copy every time the file is modified.)

The file is ready to be modified. If changes are made, the new file must be loaded onto the system to 
implement the changes (see page 77).

Getting Started
Dialog Box
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Discovering a System
If you cannot locate your AMX AutoPatch CD with the original configuration file, contact technical 
support (see page 43) with your system’s serial number for a replacement copy of the original 
configuration file. Or download XNConnect and the INI Updater from www.amx.com and follow the 
instructions below to discover your system.

The discovery process queries the attached system for configuration information and properties, 
including information regarding assigned signals and virtual matrix definitions. We recommend 
disconnecting any third-party control devices from the enclosure’s serial ports before starting the 
discovery process. The discovery process may take several minutes to complete.

To discover a system:

1. Disconnect any third-party control devices from the Epica DGX 144 enclosure’s serial port and 
USB port.

2. Connect the enclosure* to your computer (page 31).

3. Launch XNConnect (see page 71).

4. Open the Communication menu; select Serial Port.

5. If applicable – For a serial port other than Com 1, open the Communication menu again, select 
Change Comm Settings, and adjust the settings for the selected port (default baud rate 9600). 

6. From the File menu, select Discover System (the discovery may take a few minutes).

7. Save the discovered system’s configuration file, make a duplicate copy with a new name, and save it 
to the PC.
The new configuration file is ready to be modified. If changes are made, the new file must be loaded 
onto the system to implement the changes (see page 77).

* For systems with multiple enclosures, you can connect any of the enclosures to the PC as long as 
all of the enclosures are linked together.
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Navigating the Interface
XNConnect displays configuration information in two panes. The graphics are located in the left pane, 
and the properties of the currently selected graphic are in the right pane. At the top of the left pane are 
two tabs, Hardware and Virtual Matrices, for accessing the Hardware and Virtual Matrix views 
(see below). To see the details and components of a device or a virtual matrix, click the plus “+” symbol 
to the left of the device or the virtual matrix.

Most configuration file modifications involve entering information in a series of dialog boxes that are 
accessed by right-clicking a hardware device or virtual matrix icon and selecting an option from the 
shortcut menu. If you have a question regarding an open dialog box, press the F1 key for Help.

Hardware View

The Hardware view displays the system’s hardware, such as enclosures, boards, and serial ports.

Virtual Matrix View

The Virtual Matrix view displays properties of the existing virtual matrices. Most common tasks are 
conducted from this view, including customizing channel names and creating local presets.

FIG. 37  XNConnect interface with Hardware tab selected

Hardware tab Virtual matrices tab Highlighted device Properties of highlighted device

Device firmware version

Primary

This view will also show linked

Components of the
primary device

device

AMX AutoPatch primary devices

Communication settings
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Modifying a Configuration File
Modifying a configuration file with XNConnect involves entering information in a field or in a series of 
dialog boxes. A brief look at the contents in the Help file provides a quick overview of the possible 
modifications.

This section provides instructions for two common tasks: modifying channel names and configuring 
local presets. For complete coverage of configuration related tasks, see the XNConnect Help file.

Modifying Source and Destination Channel Names

If the system is using APWeb for control, the names for the source and destination channels displayed in 
the XBar can be customized in XNConnect. The custom names (labels) can be up to 23 characters and 
cannot contain the following characters: ‘  “  \  =  ?  <  >

To customize the channel names:

1. In the Virtual Matrices view, click the “+” to the left of the Virtual Matrix.

2. Click the “+” to the left of the Sources or Destinations folder.

3. Select the channel you want to rename.

4. Enter the new name in the Name field in the right-hand pane and press Enter.
The new channel name replaces the default channel name in the Sources or Destinations list.

Note: If a channel is in more than one VM, you must repeat Step 4 for the channel in each 
of the VMs.

5. Customize additional channels by repeating Steps 3 and 4.

When finished, load the configuration file onto the system (see page 77). If channel names are the only 
modifications that have been made to the file, use the “Configure System Namespace” option (found 
under Configure \ Configure Special – Virtual Matrix).

Caution: The system must not be actively switching when loading this information onto the system.

Name field – edit in place

Customized channel name

Selected channel name

Default channel name

(displays selected channel)
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Creating Local Presets

A local preset is a predetermined collection of switches on the same virtual matrix to be routed 
simultaneously. Executing a local preset affects only those inputs and outputs specified, not the whole 
system. Local presets are defined using XNConnect and can be executed a number of ways: using a 
remote control panel or using BCS commands entered as part of a macro in APControl 3.0 or APWeb or 
entered in a terminal emulation program. The process for creating local presets involves three dialog 
boxes that cover managing, naming, and modifying presets.

The Epica DGX 144 supports a maximum of 335 local presets.

The instructions below are for creating a local preset. For detailed information on modifying and 
deleting local presets, see the XNConnect Help file.

To create a new preset:

1. In the Virtual Matrices view, right-click the virtual matrix the preset will be created for and select 
Manage Local Presets from the shortcut menu.
The Manage Local Presets dialog box opens.

2. Click the Name New button.
The Name New Preset dialog box opens.

3. Optional – Enter a different preset number (local presets do not need to be numbered sequentially).

4. Enter a name for the new preset.

5. Click OK.
The Modify Preset dialog box opens.
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6. For the first switch, click the source channel (input) and one or more destination channels (outputs). 
Select multiple destination channels by holding down the Control key while selecting the channels.

7. Click the Assign Switch button. 
The input appears in the Assignment column of the Destination Channels list; the switch will 
execute when the local preset is executed.

8. Disconnect inputs* or outputs as part of the local preset by selecting either the source or destination 
channel and clicking the Disconnect button.
The input or output appears in its corresponding Disconnected Channels list; the input or output will 
be disconnected when the local preset is executed.
* Disconnecting an input will disconnect all outputs the input is connected to.

9. Repeat Steps 6, 7, and 8 for all switches and/or disconnects to be included in the preset.

Note: For information on the other buttons and preset modifications, press F1 while the 
Manage Local Presets dialog box is open.

10. After all switches for the preset have been assigned, click OK and then close the Manage Local 
Presets dialog box.

11. Define additional local presets by repeating the steps.

Caution: The system must not be actively switching when loading this information onto the system.

12. When all local presets have been defined, load the configuration file onto the system (see page 77). 
If local presets are the only modifications that have been made to the Configuration file, use the 
“Configure All Local Presets” option.

13. From the File menu, select Save As and save a file with a new name to the PC.
We strongly recommend making a duplicate copy every time the file is modified.

The Disconnected Channels box 
shows that Output 1 will be 
disconnected as part of Preset 1.

The Assignment column shows 
switches that will be executed 
as part of Preset 1: 
Input 2 to Output 5
Input 3 to Output 6 
Input 7 to Outputs 8 and 9
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Loading a Configuration File
Once modifications have been made to the configuration file, the new file must be loaded onto the 
system’s CPU for the changes to be implemented.

The two basic options for loading a configuration file are:

z Load the entire file using the “Configure All” option (see Caution below).

z Load part of the file using one of the “Configure Special” options.

To determine which configuration option to use, see “Configure Menu Commands” in the Help file.

When loading any part of a configuration file, the matrix switcher must not be actively switching. You 
may want to disconnect any external controllers to be sure that no switches are executed during the 
loading of the file.

Caution: Using the “Configure All” option or the “Configure All Virtual Matrices” option will erase any 
global presets (for global preset information, see the “Instruction Manual – BCS Basic Control 
Structure Protocol”) that have already been defined for the system. 

To load the modified configuration file from XNConnect to the Epica DGX 144 CPU:

1. Using Save As (under the File menu), make a duplicate copy of the modified file with a new name 
and save it to the PC. (We strongly recommend making a duplicate copy every time the file is 
modified.)

2. Connect the Epica DGX 144 enclosure* to your computer (see page 31).

3. Open the Communication menu and select Serial Port.

4. Open the Communication menu again, select Change Comm Settings. Check the settings for the 
selected port (the default is Com 1, Baud Rate 9600) and adjust if necessary.

5. Optional – Click the Test button to verify that communication has been established with the 
Epica DGX 144. Click OK.

6. From the Configure menu, select the appropriate configuration option (for an explanation of 
Configuration menu options, see the Help file). 

The system automatically reboots (applies to non-hardware configuration options only; for hardware, 
select the appropriate configuration option and then Configure > Reboot All Devices).

* For systems with multiple enclosures, you can connect any of the enclosures to the PC as long as all 
the enclosures are linked together.

Device Discovery Support
XNConnect v2.10.0 supports Device Discovery. Typically the default string generated by XNConnect is 
all that is necessary. 

However, certain conditions may warrant a custom string, such as the need to limit the VMs that are 
available for control by an AMX control system. Or a need may exist to limit the features available for a 
system, e.g., omitting the ability to adjust input gain, but leaving support for output volume in an Epica 
DGX 144 system that links to enclosures with adjustable audio. 

To customize the configuration string, see the XNConnect Help file topic “Device Discovery Config 
String Input.”
77Epica DGX 144 Instruction Manual



Appendix B – Managing Configuration Files
78 Epica DGX 144 Instruction Manual



Appendix C – APDiagnostics
Appendix C – APDiagnostics

Overview
APDiagnostics is a software application that monitors and displays advanced diagnostic information 
about the Epica DGX 144. (APDiagnostics also works with other AMX AutoPatch products that are 
capable of reporting such data). This application is available on the AMX AutoPatch CD or at 
www.amx.com.

System Requirements
T Windows® 2000 or Windows® XP Professional

T Java Runtime Environment (JRE):  v1.5 or the latest version

T Minimum Hardware: 166 MHz, 128 MB RAM, 20 MB of free disk space*, 
800x600 display, serial port

T Reccommended Hardware: 2.0 GHz, 512 MB RAM, 100 MB free disk space*, 
dual 1024x768 monitor display, Ethernet port**

* The installation process requires 20 MB of disk space for the APDiagnostics installer and 200 MB of 
disk space for the JRE v1.5 that is packaged with the installer (if required). Once installed, 
APDiagnostics requires 5 MB and JRE v1.5 requires approximately 100 MB of disk space.

** We strongly encourage using the Ethernet link whenever possible due to the volume of data involved 
with monitoring diagnostics. See “Communications” on page 92.

Installing APDiagnostics 
You will need administrative rights to install APDiagnostics; contact your Network Administrator.

Note: The default port when APDiagnostics is first launched is the Ethernet port.

To install APDiagnostics using the Ethernet port (recommended):

1. Connect an RJ-45 cable to the Ethernet Link (10/100) port on the Epica DGX 144. Use a 
null-modem crossover RJ-45 cable wired to TIA/EIA specification TIA/EIA-568-B on one end 
and TIA/EIA-568-A on the other.

2. Attach the other end of the RJ-45 cable to a PC.

3. Insert the AMX AutoPatch CD into your CD drive to start automatically. 
If the CD does not autorun, explore the CD folder and double-click the Index.html file.

4. Select Software and find APDiagnostics.

5. Optional – Select Release Notes to read about the software before installation.

6. Select Install; follow the directions in the subsequent dialog boxes.

7. Open APDiagnostics in Acquisition mode.* 

8. Select Comm > Settings.

9. Select the Ethernet tab and set the NIC ID.

10. Click Accept.

* The default preference is to open APDiagnostics in Acquisition mode.
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To install APDiagnostics using the serial port:

1. Attach a null modem serial cable without hardware flow control to the serial port (DB-9) 
on the Epica DGX 144. Use a null modem cable that matches the pin diagram below for RS-232. 
AMX AutoPatch equipment uses pins 2, 3, and 5 only.

2. Attach the other end of the null modem cable to a PC.

3. Use serial communication software to make sure the PC’s baud rate is 
set correctly for the system. The recommended (default) settings for 
serial communication for an Epica DGX 144 are provided in the table 
to the right.

4. Insert the AMX AutoPatch CD into your CD drive to start 
automatically. If the CD does not autorun, explore the CD folder and 
double-click the Index.html file.

5. Select Software and find APDiagnostics.

6. Optional – Select Release Notes to read about the software before 
installation.

7. Select Install; follow the directions in the subsequent dialog boxes.

8. Open APDiagnostics in Acquisition mode.* 

9. Select Comm > Settings.

10. Select the Serial Port tab and set the Comm ID and baud rate (9600).

11. Click Accept.

* The default preference is to open APDiagnostics in Acquisition mode.

PC: DB-9
AutoPatch: DB-9

Epica DGX 144 
Serial Port Settings

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1

Flow Control None
80 Epica DGX 144 Instruction Manual



Appendix C – APDiagnostics
Modes
Note: If the system contains multiple enclosures, you will be prompted to select the enclosure before 
you select the mode.

This program can be opened in one of two modes: Acquisition or Emulation. 

Acquisition Mode

Note: Only a single instance of the application can run on a PC when in Acquisition mode.

Acquisition mode is used to gather and display real-time diagnostic data from an attached AMX 
AutoPatch Distribution Matrix. For this mode to be used effectively, we recommend using a dedicated 
PC because the Epica DGX 144 must be connected to your PC via the Ethernet port (default) or serial 
port and the program must be running continuously to acquire data. This data consists of system-critical 
operating parameters, as well as general information about hardware and control configuration. As the 
data is gathered, it is automatically archived on the host PC’s hard-drive.

The three types of files maintained by APDiagnostics are:

z Date-stamped log

z .acp (packet)

z Activity

The archived files can be emailed to technical support for trend analysis and troubleshooting or can be 
opened by APDiagnostics in Emulation mode for analysis.

Emulation Mode 

This mode is an “off-line” mode used to process and display data that was gathered from an actual 
system in Acquisition mode. This mode allows the user to “play back” the system’s behavior during a 
specified period of time for trend analysis and troubleshooting.
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Main Screen and Menus

Note: Custom window colors can be applied to the Main Screen. For instructions on modifying the 
Main Screen’s color, see the APDiagnostics Help file.

Categories Pane

The Categories pane is the left-most pane in the Main Screen and presents the highest-level information 
about the overall system status. The Categories pane has two tabs: Diagnostics and System. 

When maximum and minimum levels of operation for various components in the system are exceeded, 
APDiagnostics flags that information as warnings or errors (depending on the data received) by 
changing the color of the Categories buttons in the Categories pane to yellow for warning or red for error 
and by displaying the information as Warnings or Errors in the Event Status Notebook at the bottom of 
the window.

FIG. 38  Main screen in Emulation mode (the Comm menu option is not available in this mode)

Menu
File

Load Log Files (Emulation mode only)
Zip Log File

Options
Show > Activity Log
Reload (Acquisition mode only)
Window Color
Preferences

Comm (Acquisition mode only)
Connect
Disconnect
Settings (Ethernet or serial port)

Help

Event Status Notebook

Categories Information System Visual
 Pane  Pane  Pane

Menu
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Diagnostics Tab

System Tab

The two buttons on the Diagnostics tab (Temperature and Power System) will turn 
green, yellow, or red indicating Good, Warning, or Error state, respectively. A yellow 
for warning or red for error button indicates that the maximum or minimum levels of 
functioning for various components in the system have been exceeded. This allows 
you to “drill down” into that particular sub-system for more detailed information 
about the state of its lowest-level constituents.

To display diagnostic information for Temperature 
and Power System groups:

1. In the Categories pane, select the Diagnostics tab.

2. Click either the Temperature or Power System button. 
Visual, Plot, and Details buttons display in the Information pane (see page 84).

The five buttons on the System tab offer general information for the following:

z Enclosure Info 

z VM Configurations

z Hardware Boards 

z Power Supply Info 

z Signal Sense (for inputs)

To display general information for a particular component:

1. In the Categories pane, select the System tab.

2. Click one of the five buttons on the System tab.
The details display in the Information pane (see page 85).
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Information Pane

The Information pane is the center panel in the Main Screen 
and offers the next level of “drill down” into the system 
status. Information pane buttons access information for each 
of the specific group components listed. The type of 
information displayed in the Information pane depends on 
which tab is active in the Categories pane and which 
Categories button is selected.

To display diagnostic information:

1. In the Categories pane, select the Diagnostic tab.

2. Select either the Temperature or Power system buttons 
as applicable.

3. In the Information pane:

a. Click the Visual button to display visual details on 
the enclosure in the System Visual pane. 
For more information, see page 86.

b. Click the Plot button to display a Plot View with 
a graph of data points for information being gathered 
(Acquisition mode) or already gathered (Emulation 
mode) for a specific component. The data is date 
stamped as it is added to the graph. 
For more information, see page 85.

c. Click the Details button to display a set of analog 
status meters each representing current data for its 
associated component. The meters provide an analog 
representation of a component’s current value with 
respect to its Warning and Error setpoints. If the value 
is below its minimum or exceeds its maximum 
Warning or Error setpoint, the color of the meter 
changes from green (Good) to yellow (Warning) or 
red (Error), making it easy to identify problem areas 
at a glance.

a.

b.

c.
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Information Pane Plot Views

A Plot Views window displays a graph of data points for its associated components. The graph has a 
legend at the right and is time-stamped in intervals across the bottom. The amount of historical data 
points presented in the graph can be determined by changing the settings in the Application Preferences 
dialog box (see page 88).

The legend in a Plot View is selectable; doing so will filter the view so that only the selected items are 
displayed. Furthermore, if only a single item is selected, its Warning and Error setpoint values will also 
be displayed in the window for reference.

Tip: For a hard copy of a graph, save as a .png file, then print the .png.

For information on changing the viewing of the graph, see the APDiagnostics Help file.

To display System information:

1. In the Categories pane, select the System tab.

2. Click the desired System button to display its corresponding details in the Information pane:

To access graph options:
Right click on the graph and select a shortcut menu item.

Properties – opens a Chart Properties dialog box with
three tabs:  Title, Plot, and Other.
Save as – opens a standard Save dialog box.
Print – opens a standard Page Setup dialog box.
Zoom In – provides options to zoom in on Both Axes, 
Domain Axis, or Range Axis.
Zoom Out – provides options to zoom out on Both Axes, 
Domain Axis, or Range Axis.
Auto Range – provides options for auto display of Both 
Axes, Domain Axis, or Range Axis.

z Enclosure Info – Enclosure Info, XNNet ID, Firmware Version Driver,
Version Build Date.

z VM Configurations – A table with the VM Name, VM Number, Inputs, 
and Outputs.

z Hardware Boards – A table with board numbers for Inputs, Outputs, and 
Center boards.

z Power Supply Info – Model number, Serial number, Revision, and Service 
Hours for each power supply. (If a power supply is listed as “not reporting,” 
either the power supply is not physically present or it is not being reported 
by the enclosure.)

z Signal Sense (input) – A table indicates whether a signal is present on each 
of the input channel connections on the switcher. The signal may or may not 
be routed, but the source device must be connected and powered on for the 
table to indicate that the signal is present.

Note: The Signal Sense table does not show crosspoint status.
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System Visual Pane

Event Status Notebook

The Event Status Notebook is the panel with four tabs at the bottom of the Main Screen. The tabs in the 
Event Status Notebook provide current data (Acquisition mode) or previous data (Emulation mode). 
It provides updated status entries as the system is being monitored, providing a snapshot glance of the 
most recent state of the system.

The System Visual pane is the right-most panel in the Main Screen and 
presents a simple graphic representation of the different groups being 
monitored by the application.

To display an appropriate image in the System Visual pane:

1. In the Categories pane, select the Diagnostics tab.

2. In the Information pane, click the Visual button for the applicable 
Temperature Groups.

When components in the system exceed their 
maximum and minimum levels of operation, 
APDiagnostics flags that information as 
warnings or errors depending on the data 
received. APDiagnostics changes the color of 
the Categories buttons in the Categories pane 
(top arrow) to yellow for warning or red for error 
and displays the information as Warnings or 
Errors in the Event Status Notebook (bottom 
arrow).

The information displayed in the Event Status Notebook is sorted under the following tabs: All Events, 
Notices, Warnings, and Errors.
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Note: A yellow or red outline around a data line indicates that the component was previously in 
a Warning or Error state.

To view information in the Event Status Notebook:

1. Click the applicable tab:

z All Events – comprehensive and sequential listing of all Notices, Warnings, and Errors

z Notices (green checkmark) – data list collected indicating a status of “Good”

z Warnings (yellow !) – data list collected that indicates the Warning set point (high or low) has 
been exceeded

z Errors (red !) – data list collected that indicates an Error state, i.e., has surpassed or exceeded 
its allowable maximum or minimum set point

Data lines display for every component that is queried and provide:

z “Green checkmark” (Notice) or “yellow !” (Warning) or “red !” (Error)

z Component description (e.g., Center board 2, POL 1 power)

z General status description (e.g., GOOD, has surpassed . . ., etc.)

z Date/time-stamp for the event (e.g., 8/03/07  5:15:50 PM)

z Amount of elapsed time that the component has been in that state (e.g., 7m:25s)

To access a data line context menu:

1. Select and then right-click a data line in a list. The context menu options are: 

z Show Graph – opens a Plot View of the data points for that component

z Date/time-stamp(s)* (information only; not selectable) – indicates the most recent time that 
the component was in that respective state

z Reset Selected Item*

z Reset All Items

* These menu items only appear when a data line is outlined in yellow or red.

Tabs

Data Lines
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Types of Files

The following three types of files are zipped and archived. The file name for each includes the date and 
time zipped, e.g., Diagnostic_03.02.09_14.24.50.zip (zipped on March 2, 2009 at 2:24:50 pm).

z Log (.apd, .zip) – contains all data displayed in the APDiagnostics interface in text format. 
Can be loaded when the program is opened in Emulation mode to view data for trend analysis 
and troubleshooting; see page 91.

z Packet (.acp) – contains all system activity data (packet transactions between APDiagnostics 
and the enclosure) in libpcap format. Advanced users can open .acp files with a packet/
network analyzer, such as “Analyzer” (http://analyzer.polito.it/).

z Activity (.log) – displays system activity in the Activity Log dialog box in text format.

Application Preferences

To access the Application Preferences dialog box and set preferences:

1. Select Options > Preferences.
The Preferences dialog box has two tabs: General and Logging.

General Tab

To set general application preferences:

1. For the upper set of preferences, click the applicable Enabled check boxes.

z Always Perform Live Network Discover* (selected by default)

z Open Activity Viewer at Startup

z Use Last Comm-Link at Startup (selected by default)

z Show Mode-Selection Dialog at Startup (selected by default)

z Auto-Connect in Acquisition mode (selected by default)

2. For the lower set of preferences, edit information in place (Help boxes appear).

z Emulation Mode Packet Interval

z Cached Probe History

3. Click OK.

* If this preference is “off,” the program will use the last XNNet ID stored in its registry (and expects 
that enclosure to be present).

Click to enable

Edit in place
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When processing a set of archived files in Emulation mode for analysis, you can control how fast or slow 
the files are processed by adjusting the “Emulation Mode Packet Interval” setting on the General tab of 
the Application Preferences dialog box. If you are viewing graphs while the data is being processed, 
specifying a larger interval value will allow the program to be more responsive as the Plot Views can be 
processor intensive in the face of fast playbacks.

Tip: It is important to note that APDiagnostics keeps a cache of historical data points in memory for 
status of all components that it monitors. These data points can then be displayed in the Plot Views 
for trend analysis. You can control the amount of system memory APDiagnostics will use for this 
historical data by setting the “Cached Probe History” value on the General tab. (Max. Cached Probe 
History = 168 hours. For default values, see the dialog box.) Large history sets may impede 
performance of the application, so set this value in accordance with the resources available on the 
target PC.

Logging Tab

To set the preference for Start .acp Logging At Startup:

1. Click the Enabled check box.

2. Click OK.

To change settings:

1. Edit in place (for default values, see the dialog box):

z Log File Maximum Size*

z Diagnostic Log Directory Max Size

z ACP Log Directory Max Size

z Activity Log Viewer Directory Max Size

2. Click OK.

* Log files are automatically zipped when the maximum size specified in this field is reached. This size 
value applies to all three log file types.

Tip: The amount of disk space allocated for archived files can be controlled by specifying the 
amount of disk space to allocate for each of the three file types that are generated and archived 
while APDiagnostics is running in Acquisition mode. You can also specify how big the active Log file 
should get before the file is archived and a new one is started. These parameters are specified on 
the Logging tab.

Click to enable

Edit in place
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To specify the root level folder for storing all Log files:  

1. Browse the Parent Directory For Log Files.

Once specified, the files are stored as follows:

z .apd files in a subfolder named “diagnostic”

z .acp in a subfolder named “acp”

z .log files in a subfolder named “activity”

Note: The “Diagnostic Log File Name” and the “.acp Log File Name” can be changed by editing in 
place, but cannot have a specified path.

Zip Log Files

In the event that you need to zip a set of files and send them to technical support, use the Log File Zip 
Utility dialog box to create a single archive file to email.

To zip log files:  

1. Select File > Zip Log Files.

2. Click the Include check boxes for all of the files needing zipped.

z Click individually or use any of the first three option buttons along the bottom.

z Select multiple, consecutive files by holding down the Shift key and clicking the first and last 
files in a range of files.

z Select multiple, nonconsecutive files by holding down the Control key and clicking on 
individual files.

3. Click the Zip Files button at the bottom.

Browse Parent Directory for Log Files
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Load Log Files (Emulation Mode Only)

To load log files:

1. Select File > Load Log File.

2. From the Open dialog box, navigate to the location the application is storing the .apd files (the 
default location is LogFiles > Activity in the installation directory).

3. Open the desired .apd and/or .zip file(s). The Status bar at the bottom indicates which file is being 
processed (e.g., “Processing file 2 of 3”).

Activity Log

A diagnostics window where all activity is logged in detail keeps track of the application’s activity while 
it is running. The logging can be paused and resumed as required. The logged information can also be 
deleted (Clear Pad). The level of logging can be specified as: Critical, General (default), or Detailed.

To select options in the Activity Log:

1. Select Options > Show > Activity Log.

2. Click Pause Logging or Clear Pad as needed (change Log Level if desired).
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Communications
APDiagnostics communicates with a single enclosure at a time in Acquisition mode. (Only a single 
instance of the application can run on a PC when in Acquisition mode.)

Note: The Comm menu item is available only in Acquisition mode because communication with a 
system is not required to run APDiagnostics in Emulation mode.

The communication link can be disconnected at anytime (thus freeing up the Comm port for use by other 
applications) and then reconnected when needed. The program will reset itself when the reconnection 
occurs. Due to the potentially high volume of information being processed from the attached enclosure, 
we recommend using the Ethernet connection whenever possible. 

To change the Comm Settings (in Acquisition mode only): 

1. Select Comm > Settings.

2. Ethernet – Select the Ethernet tab and set the NIC ID.*
Or
Serial Port – Select the Serial Port tab and set the 
Comm ID and baud rate.

3. Click Accept.

* If the NIC ID (MAC Address) is not already displayed, you 
can find it by going to the Start menu at the lower left of your 
monitor: 1) Select Start/Settings/Control Panel. 2) Open 
Network Connections. 3) Right click on the Local Area 
Connection (under LAN or Internet) and select Properties. 
4) Hover the mouse pointer over the entry in the Connect Using 
field to display the MAC Address (e.g., 00-1E-4F-A1-82-5D).
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Appendix D – Programmer’s Interface 
for System Diagnostics

System Component Information
The Epica DGX 144 displays system information in its splash screen* for diagnostic purposes. The 
information indicates the current status and well-being of the system components.

The splash screen can be accessed using a terminal emulation program, such as HyperTerminal
(see page 40). One of four verbosity** settings is specified to provide a level of detail for information on 
seven system components. Only one verbosity setting and one component setting can be entered in a 
command. The order in which the verbosity and component identity settings are entered is 
interchangeable.

Note: In a multiple-enclosure system, the splash screen displays information only for the enclosure 
that is connected directly to the PC.

* AMX reserves the right to add to the contents of the splash screen at any time, without notice.

** Verbosity (i.e., wordiness) refers to the amount of information provided; the higher the verbosity 
setting, the more information is displayed. 

FIG. 39  Example of a default Epica DGX 144 splash screen

Command entered to display minimal information 
for all system components

The system’s component identity numbers are 
to the left of each component 

~scr!
[1:Enclosure] AutoPatch EpicaDG
[2:Storage Blocks] cleared
[3:Communication Interfaces] count = 3
[4:Hardware Boards] detected
[5:VM Configuration] count = 1
[6:Power System] good
[7:System Sensors] detected
93Epica DGX 144 Instruction Manual



Appendix D – Programmer’s Interface for System Diagnostics
Verbosity Settings

The verbosity (v) settings (v0, v1, v2, v3) correspond to the level of detail that will be displayed, 
with v0 being the lowest level of detail and v3 being the highest level. 

Component Settings

Detailed information for a single system component can be specified by using its identity (i) number 
setting (i1 through i7) in the following table. Minimal information for all components can be specified 
by using the identity number i0. 

Default Settings

z At system boot, the ~scrv0i1 setting is displayed (FIG. 21 on page 40).

z If the verbosity setting is omitted, the verbosity level will be the lowest (v0).

z The component setting must be included; otherwise, entering any of the verbosity settings 
alone will result in a display equivalent to v0i0. 

z If both settings are omitted during a query (~scr!), the information displayed will be at the 
lowest verbosity level for all components (v0i0) (FIG. 39 on page 93).

Using BCS to Access System Diagnostic Information
Instructions are provided for accessing the lowest level of verbosity for all components and for accessing 
a specific level of verbosity for a specific component.

To access the lowest level of verbosity for all components: 

1. Enter ~scr! or ~scrv0i0!

Note: Either of these commands provides a “menu” of the identity numbers and their corresponding 
components (FIG. 39 on page 93).

Only one verbosity setting and one component identity number can be entered in a command. The order 
in which they are entered is interchangeable.

To access a specific level of verbosity for a specific component:

1. Enter ~scr (to access the splash screen).

2. Enter the verbosity level setting v# and the component (index) setting i#. 
Either may be specified first.

3. Enter ! (to send the command).

Example 

~scrv3i6!  or  ~scri6v3! (Either displays the highest level of detail for the Power System.)

Component Identity Number

All Components i0

Enclosure i1

Storage Blocks i2

Communication Interfaces i3

Hardware / Boards i4

VM Configuration i5

Power System i6

System Sensors i7
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Splash Screen Examples

Following are five examples of splash screen information that could display when different 
verbosity/component settings are specified. Depending on the amount of detail provided, you may need 
to scroll to see all of the information displayed.

.

FIG. 40  Display for v3i1 (verbosity 3, component 1)

FIG. 41  Display for v1i7 (verbosity 1, component 7)

~scrv3i1!
[1:Enclosure] AutoPatch EpicaDG
   [host software] v3.4.1
   [hardware driver] v1.0.3 R
   [build date] Aug 03 2010 05:15:02
   [pld version] A2
   [xnet address] 0xeef4
   [ap system id] 0x0
   [nvram status] valid..user preferences restored
   [nvram magic] 0xdedafaba

~scrv1i7!
[7:System Sensors] detected
   [cpu pol] detected
   [io board 5 sensors] detected
   [center board 1 sensors] detected
   [center board 2 sensors] detected
   [fan controller 1] detected
   [fan controller 2] detected
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Note: AMX reserves the right to add to the contents of the splash screen at any time, without notice.

FIG. 42  Display for v3i7 (verbosity 3, component 7)

FIG. 43  Display for v3i6 (verbosity 3, component 6)

FIG. 44  Display for v3i4 (verbosity 3, component 4)

~scrv3i7!
[7:System Sensors] detected
   [cpu pol] detected
      [temp] 51c
   [io board 5 sensors] detected
      [temp 1] 32.3c
      [temp 2] 33.9c
   [center board 1 sensors] detected 
      [temp 1] 28.5c
   [center board 2 sensors] detected
      [temp 1] 29.3c

~scrv3i6!
[6:Power System] good
   [status flags] 0x0000
   [available system power] 2418w
   [required system power] 990w
   [ac power slot 1] good
      [status flags] 0x0000
      [available power] 806w
      [output power] 150.850w
      [voltage] 12.248V
      [current] 12.248v

~scrv3i4!
[4:Hardware Boards] detected
  [switching drivers] count = 4
    [mtx driver 1] M21151 144 x 144 driver
       [revision code] 0x4
       [product code] 0xc0
    [mtx driver 2] M21151 144x144 driver
       [revision code] 0x4
       [product code] 0xc0
    [mtx driver 3] M21151 144x144 driver
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Appendix E – Board Replacement

Applicability

This appendix covers the removal and replacement procedure for input and output boards for the 
Epica DGX 144 listed in the tables below. Epica DGX boards are hot-swappable, i.e., the procedure can 
be done while the system is powered up; see the “Caution” at the bottom of this page.

DGX SC Fiber Boards

DGX HD-15 RGBHV Board

DGX DVI Boards 

Procedure Overview
Important: Adding or replacing boards should only be done by personnel trained to handle ESD 
sensitive parts and assemblies.

ESD Warning: To avoid ESD (Electrostatic Discharge) damage to sensitive components, 
make sure you are properly grounded before touching any internal Epica DGX 144 materials. 
Use an ESD wristband and cord with alligator clip attached to a good ground source.

Items Required

z Epica DGX 144 board(s)

z ESD wristband and cord with alligator clip

z Updated configuration file (see “Configuration Requirements” below to determine if the file is 
required)

z PC with a terminal emulation program (e.g., HyperTerminal); an RS-232 null modem cable

Configuration Requirements

z If a board is replaced with the same type of board, the configuration file does not need to be 
updated.

z If a board is added to a previously empty slot as part of an unplanned upgrade or if a board is 
replacing a different type of board, a CD has been included with an updated configuration file, 
which must be uploaded to the system (see page 101) for the new board to work.

Caution: The safety recommendations for laser products include applying power last. If instead of 
powering down during the board replacement procedure, you decide to take advantage of the 
DGX SC Fiber board’s ability to hot-swap, be sure that you follow the rest of the laser safety 
recommendations on the next page and in the instructions when replacing a DGX SC Fiber board.

Type FG # Model

Input FG1055-440 AVS-EPDGX144-OI-SC

Output FG1055-450 AVS-EPDGX144-OO-SC

Type FG # Model

Input FG1055-480 AVS-EPDGX144-VI-HD15

 Type FG # Model

Input FG1055-460 AVS-EPDGX144-VI-DVI

Output FG1055-470 AVS-EPDGX144-VO-DVI
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Safety Recommendations for Laser Products
Important: No user serviceable parts are inside an AMX AutoPatch product; service should 
only be done by qualified personnel.

Caution: Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 

Exercise caution when installing DGX 144 SC Fiber boards to avoid direct eye exposure to invisible 
laser radiation. Follow the recommendations below whenever installing or working with DGX products.

T  Be sure to apply the power only after all fiber connections are made and no fiber ends are 
exposed. 

T  Do not remove dust plugs from SC fiber connectors or the dust caps from the fiber cables until 
establishing connections; avoid direct eye exposure.

T  Make sure all cables, including fiber cables, are correctly connected and/or terminated. 

T  Before you unplug a fiber cable on an input board, disconnect the power on the DGX TX that 
is connected to the input.

T  Before you unplug a fiber cable on an output board, disconnect the switch for that output 
connector.

Replacing or Adding a Board
Important: When replacing a board, be sure to install the new board in the same slot that held the 
original board to make sure the switching commands are correct after you reconnect the source or 
destination devices.

Important: Cable management bars are not to be used as handles to remove or install boards.

In the following procedure, read each step entirely. The steps include helpful tips to avoid damage to the 
enclosure’s internal cables and connectors.

To remove and replace an Epica DGX 144 board:

1. Optional for systems with SC Fiber boards – Power down the enclosure (see the “Caution” at the 
bottom of page 97).

2. If applicable – Label and disconnect all cables on the board being replaced. If cables from adjoining 
boards obstruct access, label and disconnect them as necessary.
If the system is not powered down:

z For disconnecting a DGX SC Fiber input board – Before disconnecting the fiber cables, 
disconnect the power on the DGX TX Transmitter modules that are connected to the board’s 
input connectors.

z For disconnecting a DGX SC Fiber output board – Before disconnecting the fiber cables, 
disconnect the switches for the board’s output connectors.

3. If applicable – Remove the cable management bar (two screws at the top and two screws at the 
bottom).

4. Blank board plate – Push out on the board plate’s extractor handles as far as they will go (about a 
45° angle), and then pull the blank plate straight out of the board slot opening.
Or
Current board – Push out on the board’s extractor handles as far as they will go (about a 45° angle). 
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With the handles extended, carefully pull the board straight out of the board slot (FIG. 45). 
Place the board in an ESD approved static shield bag.

Caution: Each Epica DGX 144 board has an EMI (Electromagnetic Interference) gasket along the 
right edge of the face plate to make sure the boards fit snugly. Handle the boards carefully to avoid 
dislodging or damaging this gasket on the board being installed and on the board to its left.

Caution: For SC Fiber boards, do not remove dust plugs from the SC fiber connectors until Step 12. 

5. New board – With the board’s extractor handles in the extended (unlocked) position, line up the 
board’s edges on the board guides that are along the top and bottom of the board slot (FIG. 1). 
Begin pushing the board into the slot until each extractor starts to engage its metal extractor plate 
(lift into its folded position). 
When the extractor handles start to lift, flip the handles toward the middle of the board until they 
snap into their folded (locked) positions (which firmly seats the board).

6. If the enclosure was powered down – Reapply power. 

7. Establish serial communication with the enclosure:
a. Attach a PC to the serial port on the enclosure with an RS-232 null modem cable (pinout: 
5 GND to 5 GND, 2 RXD to 3 TXD, and 3 TXD to 2 RXD). 
b. Open HyperTerminal (typically at start/Programs/Accessories/Communications/HyperTerminal) 
and set the port settings to: baud rate = 9600, data bits = 8, stop bit = 1, parity = none, and flow 
control = none.

8. If the enclosure was not powered down – Enter ~app! in HyperTerminal to execute a soft reboot 
of the system.

FIG. 45  Push out on extractor handles and then pull board straight out
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9. Enter ~scri4v3! to verify that the system recognizes the board.
Check to be sure the new board is included in the list (FIG. 46). If not, reseat the board and enter the 
command again.

10. Optional for systems with SC Fiber boards – Power down the enclosure.

11. If applicable – Attach the cable management bar using two screws at the top and two screws at the 
bottom (do not over tighten screws).

Note: If using a cable management bar, tie the cable to the cable management bar far enough below 
the connector to allow for the manufacturer’s recommended bend radius. The bend radius for 
AMX SC terminated fiber cables is 2 inches (5 cm).

12. Attach the cables to the board’s connectors* and reconnect any other cables that were disconnected 
in Step 2 (if applicable – tie cables to cable management bars).
If the system is not powered down:

z For connecting a DGX SC Fiber input board – Avoid direct eye exposure as you 
(a) remove the dust plugs from the SC fiber connectors, (b) remove the dust caps from the 
fiber cables, (c) establish the connections, and (d) apply power to the DGX TX Transmitter 
modules that are connected to the inputs.

z For connecting a DGX SC Fiber output board – Avoid direct eye exposure as you 
(a) remove the dust plugs from the SC fiber connectors, (b) remove the dust caps from the 
fiber cables, and (c) establish the connections. 

13. If the enclosure was powered down – Reapply power.

14. Important – Update the system’s configuration file if necessary (to determine if this is necessary, see 
the next page).

15. Execute a test switch that includes a signal routed on the new board to make sure the system is 
working correctly. (Repeat for any additional new boards.)

*If you need cabling information, see the specific board chapter in this manual.

FIG. 46  Splash screen showing boards in the system (example with 6 input boards)

~scri4v3!

[4:Hardware Boards] detected

  [switching drivers] count = 4

(Scroll past switching drivers information to view board information.)  

  [input boards] count = 6

      [bid 1] C020

      [bid 2] C020

      [bid 3] C020

      [bid 4] C020

      [bid 5] C020

      [bid 6] C020

 

Number of boards listed must 
match the actual number of 
boards in the enclosure 

bid = board ID
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Appendix E – Board Replacement
Updating the System Configuration
The configuration file must be updated if:

z An input or output board is replaced with a different type of board.

z An input or output board is added to a previously empty slot and the system was not 
pre-configured for expansion.

The configuration file does not need to be updated if:

z An input or output board is replaced with the same type of board.

z An input or output board is added to a previously empty slot and the system was 
pre-configured for expansion.

If the system requires a new configuration file, the file is provided on a CD and needs to be loaded using 
XNConnect. We recommend keeping a copy of the former configuration file for reference.

To update the system configuration:
1. Attach a PC to the serial port on the Epica DGX 144 with an RS-232 null modem cable.

2. Install XNConnect from the AMX AutoPatch CD sent with the new board. (If XNConnect is already 
installed on the PC, we strongly recommend uninstalling the old version before installing a new 
version.)

3. Open XNConnect.

4. From the Communication menu, select change Comm Settings. Check the settings for the selected 
PC port (the default is Com 1, baud rate 9600) and adjust if necessary.

5. From the File menu, select Open.

6. Using the standard File Open dialog box, locate and open the XCL (*.xcl) configuration file that 
was sent with the new board. The default location is in the C:\AutoPatch\Configuration 
Software<Version>\MyXCL folder.

7. From the Configure menu, select Configure All.

8. Execute a test switch that includes a signal routed on the new board to be sure the system is working 
correctly. (Repeat for any additional new boards.)

If you cannot execute switches that include signals routed on the new board, contact technical support 
(see page 43).
101Epica DGX 144 Instruction Manual
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3000 RESEARCH DRIVE, RICHARDSON, TX 75082 USA •  800.222.0193  •  469.624.8000  •  469-624-7153 fax  • 800.932.6993 technical support  •  www.amx.com

Increase Your Revenue
through education + knowledge

In the ever-changing AV industry, continual education is key to success. AMX University is 
dedicated to ensuring that you have the opportunity to gather the information and 
experience you need to deliver strong AMX solutions. Plus, AMX courses also help you 
earn CEDIA, NSCA, InfoComm, and AMX continuing education units (CEUs).

Visit AMX University online for 24/7/365 access to:
- Schedules and registration for any AMX University course
- Travel and hotel information
- Your individual certification requirements and progress
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